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Innan du använder räknaren

Läs detta först

Om bruksanvisningen
• Under inga omständigheter ska CASIO Computer Co., Ltd. hållas

ansvarigt gentemot någon för speciella, indirekta, oförutsedda skador
eller följdskador i samband med eller som uppstår vid köp eller
användning av denna produkt och medföljande föremål. Vidare ska
CASIO Computer Co., Ltd. inte hållas ansvarigt för några anspråk av
något slag från någon annan part som uppstår till följd av användningen
av denna produkt och de föremål som medföljer den.

• Innehållet i denna handbok kan ändras utan föregående meddelande.
• Skärmarna och illustrationerna (såsom tangentmärkningar) som visas i

denna handbok är endast för illustrativa syften och kan skilja sig något
från de faktiska föremålen de representerar.

• QR Code är ett registrerat varumärke som tillhör DENSO WAVE
INCORPORATED i och i andra länder.

• Företags- och produktnamn som används i denna handbok kan utgöra
registrerade varumärken eller varumärken som tillhör sina respektive
ägare.

Viktiga funktioner
I exemplen nedan visas hur viktiga funktioner representeras i den här
handboken.

Exempel 1: 
Tangenterna ska tryckas in i den ordning som visas ovan (vänster till
höger).

Exempel 2: (π)*
Ovanstående anger att du ska trycka på  och sedan på , för att
mata in π-symbolen. Alla inmatningsåtgärder med flera tangenter visas
så här. Märkningen på tangenterna visas följt av inmatningstecken eller
kommando inom parentes.
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* Se ”Tangentmarkeringar” (sida 13) för mer information om de
tangentmarkeringar som används i det här exemplet.

Exempel 3: , , , , , 

• Individuella markörtangenter som indikeras av (1) representeras som
, , , .

• Individuella sidrullningstangenter som indikeras av (2) representeras
som , .

Menyfunktioner
Vissa funktioner i den här handboken använder en förenklad form av
menyfunktioner som visas i exemplen nedan.

Exempel 1

 – [Other] > [π]

eller

Tryck på  och välj sedan [Other] > [π].

Operation 1

1. Tryck på .
2. Använd  och  för att välja [Other] och tryck sedan på .
3. Använd  och  för att välja [π] och tryck sedan på .
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Exempel 2

 – Calculate

eller

Tryck på , välj ikonen för Calculate-läget och tryck sedan på .

Operation 2

1. Tryck på .
2. Använd piltangenterna ( , , , ) för att välja ikonen Calculate-

läget och tryck sedan på .

Tangenten  och 
Tangenten  och  utför samma operation. I den här handboken
används  för att välja eller tillämpa en inställning och  används för
att utföra en beräkning. Observera dock att det inte spelar någon roll om
du trycker på  eller  för operationer där antingen  eller  visas.

Exempel
Om du inte uppmanas att använda ett specifikt räknarläge eller
konfigurera vissa inställningar för en exempeloperation så ska du anta att
nedanstående lägen och inställningar ska användas.

Räknarläge: Calculate
Inställningar: De första standardinställningarna för räknaren

Mer information om hur du återställer räknaren till de ursprungliga
standardinställningarna, hittar du i ”Initiera räknare” (sida 7).

Initiera räknare

Viktigt!

• Proceduren nedan initierar alla räknarinställningar, utom Contrast och Auto Power Off.
Rensar även alla data som lagras i räknarens minne.

1. Tryck på  för att gå till HOME-skärmen.
2. Använd piltangenterna ( , , , ) för att välja en ikon för ett

räknarläge och tryck sedan på .
3. Tryck på  och välj sedan [Reset] > [Initialize All] > [Yes].

• Då visas HOME-skärmen.
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Get Started-skärmen på räknaren
När HOME-skärmen visas kan du trycka på tangenten  för att visa Get
Started-skärmen som innehåller informationen nedan.
• QR Code för åtkomst till webbsidan för Get Started inom tjänsten

Worldwide Education Service (https://wes.casio.com/calc/cw/)
Webbsidan Get Started ger dig tillgång till instruktionshäften och annan
relaterad information som hjälper dig att komma igång med din räknare.

• Räknarens ID-nummer (sträng med 24 tecken)

Tryck på  för att återgå till HOME-skärmen.

Obs!

• Du kan också visa Get Started-skärmen genom att välja den i SETTINGS-menyn. Se
”Använda SETTINGS-menyn” (sida 19).

Försiktighetsåtgärder

Säkerhetsföreskrifter
Tack för att du har köpt en produkt från CASIO.
Läs igenom säkerhetsföreskrifterna innan du använder produkten
för att säkerställa att du använder den på rätt sätt. Förvara all
användardokumentation nära till hands för framtida referens.

Fara
Indikerar något som medför stor risk för dödsfall eller allvarliga
personskador.

 Försiktighetsåtgärder gällande mynt- och
knappcellsbatterier (endast fx-991CW)

Se till att batterier inte sväljs av misstag.
Särskilda åtgärder ska vidtas för att hålla batterier borta från
barn.

Om ett batteri sväljs eller om det finns risk för att ett batteri har svalts
ska du omedelbart uppsöka läkarvård.
Om ett batteri sväljs kan det orsaka kemiska brännskador,
punktionsskador på slemhinnevävnad och andra allvarliga problem som
kan innebära livsfara.
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Varning
Indikerar något som medför stor risk för dödsfall eller allvarliga
personskador.

 Displayskärm

Tryck inte på LCD-skärmen och utsätt den inte för kraftiga
slag.

Om du gör det kan LCD-skärmens glas spricka, vilket medför risk för
personskador.

Vidrör aldrig de flytande kristallerna, dvs. vätskan, inuti LCD-
skärmen om den är sprucken.

LCD-vätska som kommer i kontakt med hud kan orsaka hudirritation.
Om du får LCD-vätska i munnen ska du omedelbart skölja ur munnen
och uppsöka läkarvård.
Om du får LCD-vätska i ögonen eller på huden ska du skölja området
med rent vatten och sedan uppsöka läkarvård.

 Försiktighetsåtgärder gällande batterier

Om vätska som läckt ur ett batteri kommer i kontakt med hud
eller klädsel ska du omedelbart skölja bort vätskan med rent
vatten.

Batterivätska som kommer i kontakt med ögon kan orsaka synskador
och liknande. Skölj ögonen och uppsök omedelbart läkarvård.

Försiktighet
Indikerar något som medför risk för lindriga personskador eller
skador på egendom.
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Iaktta försiktighetsåtgärderna nedan. Om du inte gör det kan
batteriet spricka vilket medför fara för brand, personskador och
nedsmutsning av närliggande föremål genom läckande vätska.

• Försök inte plocka isär batterier och låt aldrig batterier
kortslutas.

• Försök inte ladda ett icke-laddningsbart batteri.
• Utsätt inte batterier för värme och kasta inte batterier i öppen

eld.

• Använd enbart den batterityp som anges.
• Sätt i batteriet med polerna (plus (+) och minus (–)) riktade åt

rätt håll.
• Byt ut batteriet så snart som möjligt när det är slut.

 Försiktighetsåtgärder gällande batterier

Iaktta försiktighetsåtgärderna nedan. Om du inte gör det kan
batteriet explodera eller läcka lättantändlig vätska eller gas.

• Använd enbart den batterityp som anges för den här produkten.
• Bränn aldrig batterier och kassera inte batterier i förbrännare eller i

mekaniska kross- och skäranordningar.
• Utsätt inte batterier för mycket höga eller låga temperaturer under

användning, förvaring och transport.
• Utsätt inte batterier för mycket lågt lufttryck under användning,

förvaring och transport.

Försiktighetsåtgärder vid hantering
• fx-570CW: Även om räknaren fungerar normalt ska du byta batteriet

minst en gång vartannat år (R03).
fx-991CW: Även om räknaren fungerar normalt ska du byta batteriet
minst en gång vartannat år (LR44).
Ett urladdat batteri kan läcka, vilket kan leda till skada och att räknaren
inte fungerar som den ska. Lämna aldrig ett urladdat batteri i räknaren.
försök inte använda räknaren när batteriet är helt urladdat (fx-991CW).

• Du kommer att debiteras för fel eller skador som uppstått på grund av
batteriläckage, som inte täcks av garantin.

• Batteriet som medföljer räknaren laddas ur något under transport och
förvaring. På grund av detta kan det vara nödvändigt att byta ut batteriet
tidigare än den normala förväntade batterilivslängden.

• Undvik användning och förvaring av räknaren i områden som utsätts för
extrema temperaturer och stora mängder fukt och damm.
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• Utsätt inte räknaren för kraftig stöt, tryck eller böjning.
• Försök aldrig montera isär räknaren.
• Använd en mjuk, torr trasa för att rengöra räknarens utsida.
• När du kasserar räknaren eller batterierna ska du se till att göra det i

enlighet med lagar och förordningar i ditt område.

Komma igång

Sätta fast och ta bort den främre luckan

För att ta bort den främre luckan

Innan du använder räknaren ska du ta bort den främre luckan (①) och
fästa den på baksidan (②).

Fästa den främre luckan

När du inte använder räknaren tar du bort den främre luckan (①) och
fäster den på framsidan (②).
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Viktigt!

• Fäst alltid den främre luckan på räknaren när du inte använder den. Annars kan en
oavsiktlig aktivering av -tangenten leda till att strömmen slås på och att batteriet
laddas ur.

Slå på och stänga av strömmen
Tryck på  för att slå på räknaren.
Tryck på (OFF) för att stänga av räknaren.

Obs!

• Slå på strömmen genom att trycka länge på . För att undvika att strömmen slås på
av misstag så är -tangent något lägre än de andra tangenterna.

• Om skärmen som visas nedan visas direkt efter att du har startat enheten betyder det
att återstående batteriström är låg.

Om den här skärmen visas byter du ut batteriet så snart som möjligt. Mer information
om batteribyte finns i ”Byta batteri” (sida 140).

• Räknaren stängs även av automatiskt om den inte används på cirka 10 eller 60
minuter. Tryck på -knappen för att slå på räknaren igen.
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HOME-skärmen
Om du trycker på  så visas HOME-skärmen. I HOME-skärmen visas en
lista över installerade räknarlägen.

  HOME-skärmen   Skärmen för Calculate-läget
                 

Mer information om räknarens olika lägen hittar du i ”Lista över
installerade räknarlägen” (sida 17).

Justera skärmens kontrast
1. Tryck på , välj en ikon för ett läge och tryck sedan på .
2. Tryck på  och välj sedan [System Settings] > [Contrast].

3. Använd  och  för att justera skärmkontrasten.
4. När inställningarna har justerats som du vill trycker du på .

Viktigt!

• Om justeringen av skärmens kontrast inte förbättrar skärmens läsbarhet betyder det
förmodligen att det finns lite batteri kvar. Byt ut batteriet.

Tangentmarkeringar
Om du trycker på tangenten  och sedan en andra tangent utförs den
alternativa funktionen för den andra tangenten. Den alternativa funktionen
anges av texten som är tryckt ovanför tangenten, på vänster sida.

(1) Tangentfunktion: 
(2) Alternativ funktion: (π)
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Indikatorer
Indikatorer

I tabellen nedan beskrivs de indikatorer som visas högst upp på skärmen.

Denna indikator: Betyder detta:

Knappsatsen har växlats med hjälp av tangenten
. Knappsatsen växlas tillbaka och denna

indikator försvinner när du trycker på en tangent.

MathI/MathO eller MathI/DecimalO väljs för Input/
Output i SETTINGS-menyn.

 /  / 
Aktuell inställning för Angle Unit ( : Degree, :
Radian eller : Gradian) på SETTINGS-menyn.

FIX Ett fast antal decimaler tillämpas.

SCI Ett fast antal signifikanta siffror tillämpas.

E
On har valts för Engineer Symbol i SETTINGS-
menyn.

i / ∠ Aktuell inställning för Complex Result (i : a+bi
eller ∠: r∠θ) i SETTINGS-menyn.

 / 

Det finns föregående ( ) eller efterföljande
( ) beräkningshistorik för det beräkningsresultat
som visas. Med vissa räknarlägen visar dessa
indikatorer att det finns andra beräkningsresultat
tillgängliga.

Räknaren drivs direkt av sina solceller, antingen
helt eller i någon kombination med batteri.
(endast fx-991CW)
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Använda menyer
Många av funktionerna i din kalkylator utförs med hjälp av menyskärmar.
I exemplet nedan visas åtgärder som startas från menyskärmen och som
visas när du trycker på .

Välja ett menyalternativ

För att välja ett menyalternativ använder du markörtangenterna ( , ,
, ) för att markera det och trycker sedan på . Observera att  och
 endast används när det finns flera kolumner med menyalternativ.

Navigera mellan menyhierarkier

-indikatorn till höger om ett menyalternativ betyder att det finns lägre
hierarkinivåer under det objektet. Om du väljer menyalternativet och
trycker på  eller  navigerar du till nästa lägre nivå i hierarkin. Om
du vill återgå till nästa övre nivå i hierarkin trycker du på .

Obs!

• Om du är i en lägre nivå i hierarkin i en meny med en kolumn kan du trycka på 
samt  för att återgå till nästa högre nivå.

Välja ett menyalternativ med en radioknapp ( / )

När en lista med flera alternativ visas på skärmen har varje alternativ en
radioknapp (  eller ) till vänster.  indikerar det alternativ som är valt
just nu.
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Konfigurera inställningen för ett menyalternativ
1. Markera önskat menyalternativ och tryck sedan på .

• Vad som händer härnäst beror på vilken typ av menyalternativ du har
valt.
– Om det inte finns några fler inställningar att konfigurera för det

menyalternativ du valt kommer alternativknappen bredvid den att
ändras till .

– Om menyalternativet du har valt har fler inställningar att konfigurera
visas en skärm för att välja menyalternativ. I så fall går du vidare till
steg 2.

2. På inställningsskärmen markerar du önskad inställning och trycker
sedan på .
• Du återgår då till menyobjektskärmen i steg 1 med radioknappen invid

det menyalternativ som du tidigare valde ändrat till .

Bläddra mellan skärmar

En rullningslist visas till höger på displayen när det finns så många
menyalternativ att de inte får plats på en skärm.
• Använd  och  för att bläddra mellan skärmar.
• Använd  och  för att rulla rad för rad.

För att stänga menyn och återgå till den skärm som visas före
menyn

Tryck på .

Obs!

• Du kan stänga en meny som visas genom att trycka på , , , ,  eller
 genom att trycka på . Om den visade menyn är en som visas direkt efter att

du har startat ett visst räknarläge eller om det är en lägesspecifik meny så kan du inte
stänga den genom att trycka på . I så fall måste du trycka på  för att stänga
menyn.
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Räknarens lägen och menyer

Räknarlägen

Välja ett läge på räknaren
Välj ett läge som är lämplig för den typ av beräkning du vill utföra.
1. Tryck på  för att gå till HOME-skärmen.

• Mer information om räknarens olika lägen hittar du i ”Lista över
installerade räknarlägen” (sida 17).

2. Använd piltangenterna ( , , , ) för att välja ikonen för det
räknarläge du vill använda.

3. Tryck på  för att visa startskärmen för det räknarläge vars ikon du
valde.

Lista över installerade räknarlägen

Ikon Beskrivning

(Calculate)

Allmänna beräkningar

(Statistics)

Statistiska och regressionsberäkningar

(Distribution)

Fördelningsberäkningar

(Spreadsheet)

Kalkylbladsberäkningar
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(Table)

Genererar en nummertabell baserat på en eller två
funktioner

(Equation)

Simultana ekvationer, höggradsekvationer och Solver
(funktion för att hitta värdet på en variabel som finns i
en inmatad ekvation)

(Inequality)

Ojämlikhetsberäkningar

(Complex)

Komplexa talberäkningar

(Base-N)

Beräkningar som involverar specifika talsystem (binärt,
oktalt, decimalt, hexadecimalt)

(Matrix)

Matrisberäkningar

(Vector)

Vektorberäkningar

(Ratio)

Kvotberäkningar

(Math Box)

Följande funktioner för att stödja matematikinlärning.
Dice Roll, Coin Toss: Sannolikhetssimulering
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Använda SETTINGS-menyn
För att visa SETTINGS-menyn trycker du på  samtidigt som du
använder ett räknarläge. SETTINGS-menyn inkluderar menyalternativen
nedan.

Calc Settings
Inkluderar menyalternativ för att konfigurera
beräkningsinställningar, t.ex. visningsformat för
beräkningsresultat.

System Settings
Inkluderar menyalternativ för konfigurering av
inställning för räknaroperationer, som t.ex.
kontrastjustering.

Reset
Innehåller menyalternativ för att utföra olika typer
av återställningsåtgärder.

Get Started
Visar Get Started-skärmen. Mer information hittar
du i ”Get Started-skärmen på räknaren” (sida
8).

Obs!

• Om du trycker på  när HOME-skärmen visas så visas Get Started-skärmen istället
för SETTINGS-menyn.

• Beroende på vilken skärm som visas i räknarläget kanske inte SETTINGS-menyn
visas när du trycker på .

Ändra räknarens inställningar
1. Tryck på , välj en ikon för ett läge och tryck sedan på .
2. Tryck på  för att gå till SETTINGS-menyn.

3. Använd  och  för att välja Calc Settings eller System Settings och
tryck sedan på .
• Då visas en lista med inställningsalternativ som finns i den valda

menyn.
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Skärmen nedan visar ett exempel på vad som visas när du väljer
[Calc Settings].

• Se ”Objekt och tillgängliga inställningsalternativ” (sida 20) för
inställningsalternativ som inkluderas med [Calc Settings] och [System
Settings].

4. Använd  och  för att markera det objekt vars inställning du vill
ändra och tryck sedan på .
• Här visas en lista med inställningsalternativ för det objekt du valde.

Skärmen nedan visar ett exempel på vad som visas när du väljer
[Input/Output].

5. Använd  och  för att markera det alternativ du vill välja och tryck
sedan på .

6. När inställningarna har justerats som du vill trycker du på .

Objekt och tillgängliga inställningsalternativ◆ indikerar den ursprungliga standardinställningen.

Calc Settings > Input/Output

Anger det format som ska användas av räknaren för indata- och
beräkningsresultat.

MathI/MathO◆ Indata: Vanlig text; Utdata: Format
som innehåller en bråkdel, √ , och/
eller π*1

MathI/DecimalO
Indata: Vanlig text; Utdata:
Konverteras till decimalvärde

LineI/LineO
Indata: Linear*2; Output: Decimal
eller bråkformat

LineI/DecimalO
Indata: Linear*2; Output:
Konverteras till decimalvärde
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*1 Decimalutdata används när dessa format inte kan matas ut av någon
anledning.

*2 Alla beräkningar, inklusive bråkberäkningar och funktioner matas in på
en enda rad. Samma utdataformat som för modeller utan visning med
vanlig text (S-V.P.A.M.-modeller, mm.)

Exempel på visning av in-/utdataformat:

MathI/MathO
(ursprunglig standardinställning)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

LineI/LineO

LineI/DecimalO
(Number Format: Norm 1)

Calc Settings > Angle Unit

Degree◆; Radian; Gradian
Anger grad, radian eller gradian som vinkelenhet för visning av värde- och
beräkningsresultat.

Calc Settings > Number Format

Anger antalet siffror för visning av ett beräkningsresultat.
Fix: Det värde du anger (från 0 till 9) styr antalet decimaler för visade
beräkningsresultat. Beräkningsresultaten avrundas till det angivat antalet
decimaler innan de visas.

Exempel: 1 ÷ 6
(Fix 3)
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1 6 ( )*

Sci: Det värde du anger (från 1 till 10) styr antalet signifikatna siffror för
visade beräkningsresultat. Beräkningsresultaten avrundas till det angivat
antalet decimaler innan de visas.

Exempel: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: Visar beräkningsresultat i exponentiellt format när de faller inom
intervallen nedan.
Norm 1◆: 10-2 > |x|, |x| ≥ 1010, Norm 2: 10-9 > |x|, |x| ≥ 1010

Exempel: 1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)

1 200 ( )*

* Om du trycker på ( ) istället för  när du har matat in en
beräkning så visas beräkningsresultatet i decimalform.

Calc Settings > Engineer Symbol

On; Off◆
Anger om beräkningsresultat ska visas med konstruktionssymboler eller
inte.

Obs!

• Indikatorn (E) visas högst upp på skärmen när On har valts för den här inställningen.
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Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆
Anger antingen blandat bråkformt eller oegentligt bråkformat för visning av
bråk i beräkningsresultat.

Calc Settings > Complex Result

a+bi◆; r∠θ
Anger antingen rektangulära koordinater eller polära koordinater
för beräkningsresultat för Complex-läget och polynomiallösningar för
Equation-läget.

Obs!

• Indikatorn i visas högst upp på skärmen om a+bi har valts för Complex Result-
inställningen. ∠ visas när r∠θ är vald.

Calc Settings > Decimal Mark

Dot◆; Comma
Anger om en punkt eller ett kommatecken ska visas för decimaltecknet
för beräkningsresultatet. En punkt visas alltid under inmatningen. När
punkten väljs som decimaltecken är avgränsningen för flera resultat ett
kommatecken (,). Om komma har valts är avgränsningen ett semikolon (;).

Calc Settings > Digit Separator

On; Off◆
Anger om ett avgränsartecken ska användas i beräkningsresultat eller
inte.

System Settings > Contrast

Se ”Justera skärmens kontrast” (sida 13).

System Settings > Auto Power Off

10 Min.◆; 60 Min.
Ange hur lång tid det tar innan Auto Power Off utlöses.
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System Settings > MultiLine Font

Normal Font◆; Small Font
Anger teckenstorlek för visning när du väljer LineI/LineO eller LineI/
DecimalO som Input/Output. Upp till fyra rader kan visas när Normal Font
är vald och upp till sex rader kan visas med Small Font.

System Settings > QR Code

Anger vilken version av QR Code som visas när du trycker på (QR).
Version 3: Anger QR Code Version 3.
Version 11◆: Anger QR Code Version 11.

Reset > Settings & Data

Se ”För att initiera räknarens inställningar” (sida 24).

Reset > Variable Memory

Se ”Rensa innehållet i alla minnan” (sida 37).

Reset > Initialize All

Se ”Initiera räknare” (sida 7).

Get Started

Se ”Get Started-skärmen på räknaren” (sida 8).

För att initiera räknarens inställningar

Viktigt!

• Proceduren nedan initierar alla räknarinställningar, utom Contrast och Auto Power Off.
Rensar även alla data förutom variabelt minne och Ans-data.

1. Tryck på , välj en ikon för ett läge och tryck sedan på .
2. Tryck på  och välj sedan [Reset] > [Settings & Data] > [Yes].

• Då visas HOME-skärmen.
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Använda CATALOG-menyn
Tryck på  för att gå till CATALOG-menyn. Den här menyn visar
kategorier av kommandon, funktioner och symboler i enlighet med det
räknarläge du använder och aktuell status (visad skärm eller aktuella
inställningar) för läget.

Exempel: CATALOG-meny för Calculate-läget

Obs!

• Mer information om hur du matar in kommandon, funktioner och symboler från
CATALOG-menyn hittar du i ”Avancerade beräkningar” (sida 45).

• Mer information om kommandon, funktioner och symboler som är specifika för varje
räknarläge hittar du i räknarlägesbeskrivningarna i ”Använda räknarens lägen” (sida
65).

Använda TOOLS-menyn
TOOLS-menyn som visas när du trycker på  inkluderar menyalternativ
för att utföra funktioner som är specifika för varje räknarläge och för att
konfigurera inställningar.

Exempel: TOOLS-meny för Calculate-läget

Exempel: TOOLS-meny för Table-läget

Obs!

• Menyalternativet nedan är gemensam för räknarlägen.
– Undo (se ”Ångra operationer” (sida 28).)
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Mata in uttryck och värden

Grundläggande inmatningsregler
När du trycker på  utvärderas prioritetssekvensen för indataberäkning
automatiskt och resultatet visas på skärmen.

4 × sin 30 × (30 + 10 × 3) = 120

*1 Inmatning av den avslutande parentesen krävs för sin och andra
funktioner som inkluderar parenteser.

*2 Dessa multiplikationssymboler (×) kan utelämnas.
*3 Den avslutande parentesen omedelbart innan -operationen kan

utelämnas.

Flytta markören till början eller slutet av ett inmatat uttryck

När du matar in ett uttryck kan du trycka på  för att hoppa till början av
uttrycket eller  för att hoppa till slutet av uttrycket.

Indikator för att ett inmatat uttryck eller beräkningsresultat
innehåller mer (  , )

Om du ser en pekarsymbol (  eller ) till höger om raden för ett inmatat
uttryck eller ett beräkningsresultat så innebär det att den visade raden
fortsätter till höger. Använd  och  för att rulla linjen åt vänster och
höger.
• När du ser  i den högra änden av ett beräkningsresultat så kan du

hoppa till slutet av resultatet genom att trycka på . För att hoppa till
början av en beräkningsresultatrad trycker du på .

• Observera att om du vill bläddra i det inmatade uttrycket medan både
- och -indikatorerna visas måste du trycka på  eller  först och

sedan använda  och  för att rulla.
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Slutföra parenteser automatiskt

Om du utför en beräkning som inkluderar både division- och
multiplikationsoperationer där ett multiplikationstecken har utelämnats
infogas parenteser automatiskt enligt exemplen nedan.
– Om ett multiplikationstecken utelämnas omedelbart före en öppen

parentes eller efter en avslutande parentes.
Exempel: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))

– Om ett multiplikationstecken utelämnas omedelbart före en variabel,
konstant, mm.
Exempel: 6 ÷ 2π → 6 ÷ (2π)

Indikator för inmatningsgräns

Markören ändrar form till  när det finns 10 byte eller mindre av tillåten
inmatning kvar. Om detta inträffar avslutar du beräkningsinmatningen och
trycker på .

Mata in ett uttryck med hjälp av
vanlig text (endast MathI/MathO eller
MathI/DecimalO)
Uttryck som innehåller bråk och/eller specialfunktioner som √ kan skrivas
in i vanligt textformat med hjälp av mallar som visas när vissa tangenter
trycks ned, eller när du matar in vissa funktioner från CATALOG-menyn.

Exempel: 3 1
2  + 5 3

2
1. Tryck på ( ).

• Detta matar in en blandad bråkmall.

2. Ange värden i områdena för heltal, täljare och nämnare i mallen.

3 1 2

3. Gör samma sak för att mata in resten av uttrycket.

( )5 3 2

27



Obs!

• När markören är placerad inom inmatningsområdet för en mall (blandat bråkformat,
integration (∫) och summering (Σ)), trycker du på  för att hoppa till positionen
omedelbart före (till höger om) mallen  för att hoppa till positionen omedelbart
före (till vänster om) den.

• Du kan alltid ange aktuell plats för markören i en mall eftersom det tomma inramade
området eller tecknen där den finns blir mörksvart. Allt annat i beräkningsuttrycket blir
mörkgrått.

Ångra operationer
Om du vill ångra den senaste knappåtgärden trycker du på , väljer
[Undo] och trycker sedan på .
Om du vill göra om en tangentåtgärd som du just har ångrat trycker du på

, väljer [Undo] och trycker sedan  igen.

Använda värden och uttryck som argument

Exempel: Om du vill mata in 1 + 7
6  och sedan ändra den till 1 + 

1 7 6 (INS)

Om du trycker på (INS) i ovanstående exempel blir 7
6  argumentet

för funktionsinmatningen med nästa knappåtgärd (√ ).

Skriv över inmatningsläge (endast
LineI/LineO eller LineI/DecimalO)
I överskrivningsläget ersätter text som du matar in texten på den aktuella
markörplatsen. Du kan växla mellan lägena för infoga och skriva över
genom åtgärden: (INS). Markören visas som  i infogningsläge och
som  i överskrivningsläget.
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Grundläggande beräkningar

Aritmetiska beräkningar
Använd tangenterna , ,  och  för att utföra aritmetiska
beräkningar.

Exempel: 7 × 8 - 4 × 5 = 36

7 8 4 5

Bråkberäkningar
Observera att inmatningsmetoden för bråkformat beror på den aktuella
inställningen för Input/Output i SETTINGS-menyn.

För att mata in 7
3  (oegentligt bråkformat)

(Input/Output: MathI/MathO eller MathI/DecimalO)

7 3 eller 7 3 7
3

(Input/Output: LineI/LineO eller LineI/DecimalO)

7 3

(a) Täljare, (b) Nämnare

För att mata in 2 1
3  (blandat bråkformat)

(Input/Output: MathI/MathO eller MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO eller LineI/DecimalO)
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2 1 3

(a) Täljare , (b) Nämnare, (c) Heltalsdel

Exempel: 2
3  + 1 1

2  = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

Obs!

• Bråkdelar i beräkningsresultat visas efter att ha reducerats deras lägsta term.

Om du vill konvertera ett beräkningsresultatformat till oegentligt bråkformat
eller blandat bråkformat trycker du på . Mer information hittar du i
”Konvertering av egentligt bråkformat och blandat bråkformat” (sida
42).

Beräkningsresultat för bråkformat

Ett beräkningsresultat vars totala antal siffror i blandat bråkformat
(inklusive heltal, täljare, nämnare och avskiljarsymbol ) är större än 10
kan inte visas i bråkformat. I så fall visas beräkningsresultatet som ett
decimalvärde.

Exempel 1: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

Eftersom det totala antalet siffror i värdet 1 1 123456 är 10 så visas
resultatet som ett bråkvärde.

Exempel 2: 1 1 1234567 (= 1234568 1234567) = 1,00000081
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(Input/Output: LineI/LineO)

1 1 1234567

Eftersom det totala antalet siffror i värdet 1 1 1234567 är 11 så visas
resultatet som ett decimalvärde.

Obs!

• Om du blandar bråktal och decimalvärden i en beräkning när något annat än Mathl/
MathO är valt så visas resultatet som ett decimalvärde.

Potenser, potensrötter och reciproka
tal
Använd knapparna nedan för att mata in effektfunktioner,
effektrotsfunktioner och reciprocal funktion.
Effektfunktioner: (kvadrat), (n:e potens)
Effektrotfunktioner: (kvadratrot), ( ) (n:e rot)
Reciprokal funktion: ( )

Exempel 1: (52)3 = 15625

5 3

Exempel 2: (1 + 1)2+2 = 16

1 1 2 2

Exempel 3: √2 × 3 = 3√2 = 4,242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)
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2 3

Exempel 4: 5√32 = 2
(Input/Output: MathI/MathO)

( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

Exempel 5: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

-tangent (potens av 10)

Om du trycker på -tengenten så är det samma som att trycka på 
. Båda operationerna matar in ”×10 ” (MathI/MathO eller MathI/

DecimalO) eller ”×10^(” (LineI/LineO eller LineI/DecimalO).

Exempel: 1,23 × 103 = 1230

1 23 3

√  formelberäkningsintervall

De tillåtna visningsområdena för beräkningsresultatet för formeln √  visas
nedan.

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100
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Exempel:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... Visas i formlen √ 
• 99√999 (= 297√111) = 3129,089165 ... Visas som ett decimalvärde

Pi, naturlig logaritm för basen e

Pi
Mata in π genom att trycka på (π).
π visas som 3,141592654, men π = 3,1415926535897932384626 används
för interna beräkningar.

Naturlig logaritm för basen e
Mata in e genom att trycka på (e).
Den naturlig logaritmen för basen e visas som 2,718281828, men e =
2,7182818284590452353602 används för interna beräkningar.

Beräkningshistorik och repetering

Beräkningshistorik
En  och/eller  högst upp på skärmen visar mer
beräkningshistorikinnehåll över och/eller under. Du kan rulla genom
innehållet i beräkningshistoriken med hjälp av  och .

Lägen som stöder beräkningshistorik:
Calculate, Complex, Base-N

Exempel
2 + 2 = 4

2 2

3 + 3 = 6

3 3

(Rullar bakåt)
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Obs!

• Alla beräkningshistorikdata rensas när du trycker på  eller , när du ändrar
Input/Output-inställningen eller när du utför en Reset-operation (Settings & Data eller
Initialize All).

Repetering
När ett beräkningsresultat visas på skärmen kan du trycka på , 
eller  för att redigera det uttryck du använde för den föregående
beräkningen.

Exempel
4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(Fortsättning)  7

Obs!

• Om  (vänster) eller  (höger) visas i slutet eller båda ändarna av en
beräkningsresultatrad kan du använda  och  för att rulla raden åt vänster och
höger. Om detta händer ska du trycka på  eller  först och sedan använda 
och  för att redigera uttrycket.

Använda minnesfunktioner

Svarsminne (Ans)
Det senast erhållna beräkningsresultatet lagras i Ans-minnet (Answer).

Använda Ans-minnet för att utföra en serie beräkningar

Exempel: För att dela upp resultatet av 3 x 4 med 30

3 4
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(Fortsättning)  30

Mata in Ans-minnesinnehåll i ett uttryck

Exempel: Så här utför du beräkningarna som visas nedan:

123 456

(Fortsättning)  789

Variabler (A, B, C, D, E, F, x, y, z)
Du kan lagra värden på variabler och använda variablerna i beräkningar.

Variabellistskärm

Om du trycker på  visas en skärm som visar värdena som för
närvarande lagras i variablerna A, B, C, D, E, F, x, y och z. På den här
skärmen visas värdena alltid med formatet Norm 1, Number Format. För
att stänga skärmen trycker du på  eller .

Exempel 1: För att spara resultatet för 3 + 5 till variabel A
1. Utför beräkningen.

3 5

2. Tryck på  och välj sedan [A=] > [Store].
• För att spara resultatet för 3 + 5(vilket är 8) till variabel A.

3. Tryck på .
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Exempel 2: För att ändra innehållet i variabel A till 1
1. Tryck på , och markera sedan [A=].

2. Tryck på .
• Då visas redigeringsskärmen med 1 inmatat.

3. Tryck på .

Obs!

• I stället för operationen i steg 2 ovan kan du trycka på  och sedan välja [Edit]. Då
visas redigeringsskärmen utan någonting inmatat. Mata in värdet du vill ange och tryck
sedan på .

• Om en låsikon ( ) visas när du markerar en variabel på variabellistskärmen så
betyder det att den markerade variabeln inte kan redigeras.

Exempel 3: För att ta fram innehållet i variabel A
(Fortsätter från steg 2 i exempel 1)
1. Tryck på  och välj sedan [A=] > [Recall].

• Då matas A in.

2. Tryck på .
• Innehållet i variabel A hämtas då.

Exempel 4: För att multiplicera innehållet i variabel A med 10
(Fortsätter från steg 2 i exempel 1)

(A)* 10
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* Mata in en variabel som visas här: tryck på  och tryck sedan på
den tangent som motsvarar önskat variabelnamn. För att mata in x som
variabelnamn kan du trycka på (x) eller .

Rensa innehållet i alla minnen
Ans-minnet och variabelinnehåll behålls även om du trycker på , ändrar
räknarens läge eller stänger av räknaren.
Utför proceduren nedan när du vill rensa innehållet i alla minnen.
1. Tryck på , välj en ikon för ett läge och tryck sedan på .
2. Tryck på  och välj sedan [Reset] > [Variable Memory] > [Yes].
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Ändra format för
beräkningsresultat

Använda FORMAT-menyn
Du kan använda FORMAT-menyn som visas när du trycker på  för att
konvertera ett visat beräkningsresultat till flera olika format.

Menylista för FORMAT

Det här menyalternativet:
Konverterar till det här
formatet:

Standard
Standard (inkluderar bråkformat
och formaten π, √ ).

Decimal Decimal

Prime Factor Primfaktorisering

Rectangular Coord Rektangulära koordinater

Polar Coord Polära koordinater

Improper Fraction Oegentligt bråkformat

Mixed Fraction Blandat bråkformat

ENG Notation
Teknisk notation (a×10n format, n
= exponent som är delbar med 3)

Sexagesimal
Grader, minuter, sekunder
(sexagesimal)
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Obs!

• Vilka menyalternativ som visas när du trycker på  beror på vilket beräkningsresultat
som visas för tillfället. Om ett beräkningsresultat som inte kan konverteras visas, så
visas inte heller menyn när du trycker på .

Exempel på konverteringsoperation

Exempel: 3 ÷ 2 = 3
2  = 1,5 = 1 1

2
I det här exemplet konverterar vi ett beräkningsresultat som visas som
ett oegentligt bråkformat till ett decimalvärde och sedan till ett blandat
bråkformat. Slutligen avbryter vi konverteringen och går tillbaka till det
ursprungliga beräkningsresultatet.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. Utför beräkningen 3 ÷ 2.

3 2

2. Om du vill konvertera beräkningsresultatet till ett decimalvärde trycker
du på , väljer [Decimal] och trycker sedan på .

3. Om du vill konvertera beräkningsresultatet till ett blandat bråkformat
trycker du på , väljer [Mixed Fraction] och trycker sedan på .

4. Om du vill avbryta konverteringen trycker du på .
• Då visas det ursprungliga beräkningsresultatet från steg 1.
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Konverteringar för Standard och
Decimal
Standard är ett format som visar ett beräkningsresultat i ett formulär som
innehåller en bråkdel, √  eller π när det är möjligt. Decimal är ett format
som visar beräkningsresultatet som ett decimalvärde.

Obs!

• Konvertering till Standard-format som inkluderar √  eller π är möjligt när MathI/
MathO- eller MathI/DecimalO-inställningen har valts för Input/Output-inställningen i
SETTINGS-menyn.

Du kan använda operationen nedan för att konvertera ett
beräkningsresultat till Standard- eller Decimal-format.

Exempel: π ÷ 6 = 1
6  π = 0,5235987756 (Input/Output: MathI/MathO)

(π) 6

(Välj [Decimal].)

(Konvertera till ett decimalvärde.)

(Konverterar till Standard-format.)

Viktigt!

• Med vissa beräkningsresultat konverteras inte det visade värdet om du väljer
[Standard] på FORMAT-menyn.
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För att få ett beräkningsresultat med decimalvärde när MathI/
MathO eller LineI/LineO har valts

Tryck på ( ) istället för  när du har lagt in en beräkning.

Primfaktorisering
I Calculate-läget kan ett positivt heltal på högst 10 siffror tas med i
beräkningen av primfaktorisering.

Exempel: För att utföra primfaktoreisering på 1014

1014

 – [Prime Factor]

Obs!

• Typerna av värden som beskrivs nedan kan inte tas med i beräkningen, även om de
har 10 eller färre siffror.
– En av primfaktorerna för värdet är 1 018 081 eller större.
– Två eller flera av primfaktorerna för värdet har mer än tre siffror.

• Den del som inte kan tas med i beräkningen omges av parenteser på skärmen.
Exempel: 2036162 = 2 × (1018081)*

*1018081 = 10092

2036162
 – [Prime Factor]

Konvertering av rektangulära och
polära koordinater
Du kan konvertera ett komplext talberäkningsresultat till rektangulära
koordinater (  – [Rectangular Coord]) eller polära koordinater (  –
[Polar Coord]). Denna konverteringsåtgärd kan utföras i något av följande
fall.
• När en lösning för en höggradsekvation i Equation-läget visas (under

förutsättning att du väljer On för  – [Complex Roots]-inställningen för
Equation-läget)

41



• När ett resultat för en beräkning i Complex-läget visas

För en faktisk provkonverteringsoperation, se avsnitten nedan.
”Konvertera en komplex tallösning till rektangulära eller polära
koordinater” (sida 104)
”Konvertera ett resultat för en komplex talberäkning till rektangulära
eller polära koordinater” (sida 110)

Konvertering av egentligt bråkformat
och blandat bråkformat
Du kan konvertera det bråkformat eller det decimalvärde som visas
(decimalvärde som kan konverteras till ett bråkformat med den här
räknaren) till ett bråkformat eller ett oegentligt bråkformat.

Exempel 1: 13
4  = 3 1

4
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

Exempel 2: 3,25 = 13
4  = 3 1

4  (Input/Output: LineI/LineO)

3 25

 – [Improper Fraction]

 – [Mixed Fraction]

Teknisk notation
Du kan konvertera exponentdelen av ett visat beräkningsresultat till en
effekt på tio som är en multipel av 3 och visar resultatet.

Exempel: Omvandla värdet 1234 till en teknisk notation, flytta
decimaltecknet till höger och sedan till vänster.
1. Mata in 1234 och tryck sedan på .
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2. Utför operationen nedan för att gå in läget för konvertering till teknisk
notation.

 – [ENG Notation]

• När du öppnar läget för konvertering till teknisk notation konverteras
beräkningsresultatet till en teknisk notation och då visas  till höger.

• I läget för konvertering till teknisk notation kan du använda  och 
för att flytta mantissans decimalpunkt.

3. Om du vill avsluta detta konverteringsläge trycker du på .
• Då avslutas läget för konvertering till teknisk notation och  försvinner

från skärmen.

• Du kan också avsluta läget för konvertering till teknisk notation genom
att trycka på  eller .

Obs!

• Normala beräkningar är inte möjliga i läget för teknisk notation. Om du vill starta en ny
beräkning avslutar du läget för konvertering till teknisk notation.

• Teknisk notation kan också användas med tekniska symboler. Mer information finns i
”Tekniska symboler” (sida 55).
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Sexagesimal konvertering
(beräkningar av grader, minuter och
sekunder)
Du kan konvertera ett decimalt beräkningsresultat till ett sexagesimalt
värde.

Konvertera ett decimalt beräkningsresultat till ett
sexagesimalt värde

Exempel: 1,25 = 1°15’0”

1 25

 – [Sexagesimal]

Mata in och beräkna med ett sexagesimal värde
Förutom att konvertera ett visat värde till ett sexagesimalt värde kan du
också mata in sexagesimalvärden och använda dem i beräkningar.
Syntaxen nedan används för att ange ett sexagesimalvärde:

{grader} ( ) {minuter} ( ) {sekunder} ( )
Observera att du alltid måste ange något för grader och minuter, även om
de är noll.

Exempel: Utför beräkningen 2°20’30” + 9’30”. Konvertera sedan
beräkningsresultatet till ett decimalvärde.

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

(Konvertera till ett decimalvärde.)
 – [Decimal]

(Återgå till sexagesimal visning.)
 – [Sexagesimal]
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Avancerade beräkningar
I det här avsnittet beskrivs kommandon, funktioner och symboler som
är gemensamma för alla räknarens lägen. Kommandon, funktioner och
symboler presenteras här i samma ordning som de visas CATALOG-
menyn som visas när du trycker på .

Obs!

• Det finns också räknarlägesspecifika CATALOG-menyalternativ, som inte visas här.
Mer information om de lägesspecifika menyalternativ hittar du i de olika kapitlen för
lägena.

• Beroende på vilket räknarläge du använder och vilken skärm som visas i
räknaren kanske du inte kan använda vissa kommandon, funktioner eller symboler.
Kommandon, funktioner och symboler som beskrivs här är inte tillgängliga i
CATALOG-menyn.

• Kommandon, funktioner och symboler som beskrivs här är inte tillgängliga i Base-N-
läget.

Funktionsanalys
I det här avsnittet beskrivs kommandon och funktioner som du kan mata in
efter att du har utfört operationen:  – [Func Analysis].

Derivative(d/dx)
Derivative(d/dx) erhåller den ungefärliga differenskoefficienten för angiven
x-koordinat (a) i indatauttrycket f(x).

Obs!

• Den här funktionen kan användas med något av följande räknarlägen: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Indatatsyntax

Detta indatasyntax beror på Input/Output-inställningen i SETTINGS-menyn
så som visas i tabellen nedan.
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Input/Output-inställning Indatatsyntax

MathI/MathO eller MathI/DecimalO  d
dx (f(x))|x=a

LineI/LineO eller LineI/DecimalO  d
dx (f(x), a, tol)*

* tol anger tolerans, vilken blir 1 × 10-16 när ingenting matas in för tol.

Försiktighetsåtgärder vid derivatberäkning

• När du använder en trigonometrisk funktion i f(x), ska du ange Radian
som Angle Unit i SETTINGS-menyn.

• Ett mindre tol-värde ökar precisionen men det ökar också
beräkningstiden. När du anger tol, ska du använda värde som är 1 ×
10-22 eller större.

• Felaktiga resultat och fel kan orsakas av följande:
– icke-kontinuerliga punkter i x -värden
– extrema förändringar av x-värden
– inkluderande av lokala maxpunkten och den lokala minimipunkten i

x-värden
– inkluderande av brytpunkten i x-värden
– inkluderande av odifferentierbara punkter i x-värden
– differentiella beräkningsresultat som närmar sig noll

Exempel på derivatberäkning

Bestäm f’( π
2 ) när f(x) = sin(x) (tol-specifikationen utelämnas.)

(Input/Output: MathI/MathO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output: LineI/LineO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
Den här räknaren utför integration med Gauss-Kronrod-metoden för
numerisk integration.
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Obs!

• Den här funktionen kan användas med något av följande räknarlägen: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Indatatsyntax

Detta indatasyntax beror på Input/Output-inställningen i SETTINGS-menyn
så som visas i tabellen nedan.

Input/Output-inställning Indatatsyntax

MathI/MathO eller MathI/DecimalO

LineI/LineO eller LineI/DecimalO

* tol anger tolerans, vilken blir 1 × 10-10 när ingenting matas in för tol.

Försiktighetsåtgärder vid integrationsberäkning

• När du använder en trigonometrisk funktion i f(x), ska du ange Radian
som Angle Unit i SETTINGS-menyn.

• Ett mindre tol-värde ökar precisionen men det ökar också
beräkningstiden. När du anger tol, ska du använda värde som är 1 ×
10-22 eller större.

• Beroende på innehållet i f(x) samt positiva och negativa värden
inom integrationsområdet eller integrationsområdet så kan ett stort
fel uppstå för de beräknade integrationsvärdena. (Exempel: När det
finns delar med icke-kontinuerliga punkter eller abrupt förändring. När
integrationsintervallet är för brett.) I sådana fall kan en uppdelning
av integrationsintervallet i flera delar innan beräkning förbättra
beräkningens noggrannhet.

Exempel på integrationsberäkningar

(ln(x), 1, e) = 1 (tol specificering utelämnas.)

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)
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(Input/Output: LineI/LineO)

 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)

Summation(Σ)
Med Σ( kan du erhålla summan för det inmatade uttrycket f(x) för ett
specifikt intervall.

Obs!

• Den här funktionen kan användas med något av följande räknarlägen: Calculate,
Statistics, Distribution, Spreadsheet, Table, Equation (med undantag för Solver),
Inequality, Matrix, Vector, Ratio.

Indatatsyntax

Detta indatasyntax beror på Input/Output-inställningen i SETTINGS-menyn
så som visas i tabellen nedan.

Input/Output-inställning Indatatsyntax

MathI/MathO eller MathI/DecimalO

LineI/LineO eller LineI/DecimalO

* a och b är heltal som kan anges inom intervallet för -1 × 1010 < a ≤ b < 1
× 1010.

Beräkningsexempel för Σ

 (x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)
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 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5

Logarithm(logab), Logarithm(log)
Använd (log) eller  – [Func Analysis] > [Logarithm(log)] för
att mata in logab som log (a, b). Base 10 är den ursprungliga
standardinställningen om du inte matar in någonting för a.

Exempel 1: log101000 = log 1000 = 3

(log)1000

Exempel 2: log216 = 4

(log)2 (,)16

Tangenten  (eller  – [Func Analysis] > [Logarithm(logab)]) kan också
användas för inmatning, men bara om MathI/MathO eller MathI/DecimalO
har valts för Input/Output i SETTINGS-menyn. I det här fallet måste du
ange ett värde för basen.

Exempel 3: log216 = 4

2 16

Natural Logarithm
Använd (ln) eller  – [Func Analysis] > [Natural Logarithm] för att
mata in ”ln”.

Exempel: ln 90 (= loge90) = 4,49980967

(ln)90
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Sannolikhet
I det här avsnittet beskrivs kommandon och funktioner som du kan mata in
efter att du har utfört operationen:  – [Probability].

%
Om du matar in ett värde följt av kommandot % så blir inmatat värde ett
procentvärde.

Obs!

• Du kan inte mata in % i Complex-läget.

Exempel 1: 150 × 20% = 30

150 20
 – [Probability] > [%]

Exempel 2: Beräkna vilken procentandel av 880 som är 660. (75 %)

660 880
 – [Probability] > [%]

Exempel 3: Dra av 25 % från 3500. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
Den här funktionen hämtar fakulteter för ett värde som är noll eller ett
positivt heltal.

Exempel: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
Funktioner för permutation (nPr) och kombination (nCr).
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Exempel: För att bestämma antalet permutationer och kombinationer som
är möjliga när du väljer fyra personer från en grupp av 10

Permutationer:

10
 – [Probability] > [Permutation(P)]

4

Kombinationer:

10
 – [Probability] > [Combination(C)]

4

Random Number
Den här funktionen genererar ett pseudoslumptal i intervallet 0,000 till
0,999. Resultatet visas som ett bråktal när MathI/MathO väljs för Input/
Output SETTINGS-menyn.

Obs!

• Ran# kan inte matas in i Solver- eller Equation-läget.

Exempel: För att erhålla slumpmässiga tresiffriga heltal

1000
 – [Probability] > [Random Number]

(Resultatet blir olika varje gång simuleringen körs.)

Random Integer
Den här funktionen genererar ett pseudoslumpmässigt heltal mellan ett
angivet startvärde och ett slutvärde.

Obs!

• RanInt# kan inte matas in i Solver- eller Equation-läget.

Exempel: För att generera ett pseudoslumptal i intervallet 1 till 6

 – [Probability] > [Random Integer]
1 (,)6
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(Resultatet blir olika varje gång simuleringen körs.)

Numeriska beräkningar
I det här avsnittet beskrivs kommandon och funktioner som du kan mata in
efter att du har utfört operationen:  – [Numeric Calc].

Absolute Value
När du utför en beräkning av reella tal erhåller den här funktionen helt
enkelt det absoluta värdet.

Exempel: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Round Off
Om du använder Round Off-funktionen avrundas decimalbråkvärdena för
argumentet i enlighet med den aktuella Number Format-inställningen. Till
exempel är det interna och visade resultatet för Rnd(10 ÷ 3) 3,333 när
Number Format-inställningen är Fix 3. Om du använder inställningen
Norm 1 eller Norm 2 så avrundas argumentet med den 11:e siffran i
mantissadelen.

Exempel: Så här utför du följande beräkningar när Fix 3 väljs för antalet
visningssiffror: 10 ÷ 3 × 3 och Rnd(10 ÷ 3) × 3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3
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Vinkelenhet, polär/rektangulär
koordinat, sexagesimal
I det här avsnittet beskrivs kommandon, funktioner och symboler som du
kan mata in efter att du har utfört åtgärden:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
Dessa funktioner anger vinkelenheten.
° anger grad, r radian och g gradian.
Du kan mata in varje funktion med hjälp av menyalternativen nedan.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

Exempel: π/2 radianer = 90° (Angle Unit: Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]

Rect to Polar, Polar to Rect
”Pol(” konverterar rektangulära koordinater till polära koordinater och
”Rec(” konverterar polära koordinater till rektangulära koordinater.

• Ange Angle Unit i SETTINGS-menyn innan du utför beräkningar.
• Beräkningsresultatet för r och θ och för x samt för y lagras för var och en

av variablerna x och y.
• Beräkningsresultatet θ visas i intervallet -180° < θ ≤ 180°.

Obs!

• Pol( och Rec( kan användas på beräkningsskärmen för räknarnapparna enligt nedan.•
Calculate, Statistics, Matrix, Vector

Exempel 1: För att konvertera rektangulära koordinater (√2, √2) till polära
koordinater (Input/Output: MathI/MathO, Angle Unit: Degree)
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 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

Exempel 2: För att konvertera polära koordinater (√2, 45°) till rektangulära
koordinater (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

Grader, minuter, sekunder
Du kan använda tangenterna eller menyalternativet nedan för att mata in
sexagesimalsymbolen ( ).

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

Mer information hittar du i ”Sexagesimal konvertering (beräkningar av
grader, minuter och sekunder)” (sida 44).

Hyperbolisk, trigonometrisk
I det här avsnittet förklaras hyperboliska och trigonometriska funktioner.

Hyperboliska funktioner
Hyperboliska funktioner kan matas in med hjälp av menyalternativen
nedan.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1] eller
[tanh-1]

Vinkelenhetens inställning påverkar inte beräkningar.

Exempel: sinh 1 = 1,175201194

 – [Hyperbolic/Trig] > [sinh] 1

Trigonometriska funktioner
Trigonometriska funktioner kan matas in med hjälp av menyalternativen
nedan.
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Tangent Menyalternativ

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

Ange Angle Unit i SETTINGS-menyn innan du utför beräkningar.

Exempel: sin 30 = 1
2  (Angle Unit: Degree)

30

Tekniska symboler
Räknaren stöder användningen av 11 tekniska symboler (m, μ, n, p,
f, k, M, G, T, P, E) för inmatning av värde eller för visning av
beräkningsresultat.
• Tekniska symboler kan matas in efter att operationen har utförts:  –

[Engineer Symbol].
• Om du vill visa beräkningsresultat med tekniska symboler gör du

följande:  – [Calc Settings] > [Engineer Symbol] > [On].

Exempel på indata och beräkningar med hjälp av tekniska
symboler

Exempel 1: För att mata in 500k
(Engineer Symbol: On)

500  – [Engineer Symbol] > [Kilo] 
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Exempel 2: För att beräkna 999 k (kilo) + 25 k (kilo) = 1,024 M (Mega) =
1024 k (kilo) = 1024000
(Engineer Symbol: On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
(öppnar läget för teknisk notation.)

• Om trycker på ,  eller  avslutas läget för konvertering till
teknisk notation och  försvinner från skärmen. Om du vill starta en
ny beräkning avslutar du läget för konvertering till teknisk notation.

• Mer information om läget för teknisk notation hittar du i ”Teknisk
notation” (sida 42).

Vetenskapliga konstanter
Räknaren har 47 inbyggda vetenskapliga konstanter. Värdena baseras på
rekommenderade värden för CODATA (2018).

Exempel: För att mata in den vetenskapliga konstanten c (ljusets
hastighet i vakuum) och visa dess värde
1. Tryck på , välj [Sci Constants] och tryck sedan på .

• Då visas en meny med kategorier för vetenskapliga konstanter*.

2. Välj [Universal] och tryck sedan på .
• Detta visar en meny med konverteringskommandon i Universal-

kategorin.
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3. Välj [c] och tryck sedan på .

4. Tryck på .

* Tabellen nedan visar de vetenskapliga konstanter som ingår i varje
kategori.

Kategori Vetenskapliga konstanter

Universal h, , c, ε0, μ0, Z0, G, lP, tP

Electromagnetic μN, μB, e, Φ0, G0, KJ, RK

Atomic&Nuclear
mp, mn, me, mμ, a0, α, re, λC, γp,
λCp, λCn, R∞, μp, μe, μn, μμ, mτ

Physico-Chem mu, F, NA, k, Vm, R, c1, c2, σ

Adopted Values gn, atm, RK-90, KJ-90

Other t

Enhetskonverteringar
Du kan använda enhetskonverteringskommandon för att konvertera från
en måttenhet till en annan. Konverteringsformeldata baseras på NIST
Special Publication 811 (2008).

Exempel: Så här konverterar du 5 cm till tum (Input/Output: LineI/LineO)
1. Ange det värde som ska konverteras.

5

2. Tryck på , välj [Unit Conversions] och tryck sedan på .
• Då visas en meny med enhetskonverteringskategorier*.
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3. Välj [Length] och tryck sedan på .
• Detta visar en meny med konverteringskommandon i Length-

kategorin.

4. Välj [cm in] (konverteringskommandot för centimeter-till-tum) och tryck
sedan på .

5. Tryck på .

* Tabellen nedan visar de enhetskonverteringskommandon som ingår i
varje kategori.

Kategori Enhetskonverteringskommandon

Length
in cm, cm in, ft m, m ft, yd m, m yd, mile km, km mile, n mile m,
m n mile, pc km, km pc

Area acre m2, m2 acre

Volume gal(US) L, L gal(US), gal(UK) L, L gal(UK)

Mass oz g, g oz, lb kg, kg lb

Velocity km/h m/s, m/s km/h

Pressure
atm Pa, Pa atm, mmHg Pa, Pa mmHg, kgf/cm2 Pa, Pa kgf/cm2,
lbf/in2 kPa, kPa lbf/in2

Energy kgf m J, J kgf m, J cal15, cal15 J

Power hp kW, kW hp

Temperature °F °C, °C °F

Övrigt
Funktioner och symboler som kan matas in med hjälp av räknarens
tangenter kan också matas in med hjälp av [Other]-menyn. Använd 
– [Other] för att visa funktions- och symbolmenyn. Om du till exempel vill
ange Ans kan du antingen trycka på  eller utföra följande operation: 
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*1

*2

*3

– [Other] > [Ans].
Tabellen nedan visar menyalternativet [Other] som motsvarar varje
nyckeloperation.

Menyalternativ Tangent

Ans

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 Reciprokal
*2 Kvadrat
*3 Minustecken
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Registrera och använda
definierande ekvationer för f(x)
och g(x)

Registrera och använda definierande
ekvationer för f(x) och g(x)
Din räknare har funktionerna ”f(” och ”g(” som du kan använda efter att
ha registrerat definierande ekvationer för dem. Till exempel, efter att ha
registrerat f(x) = x2 + 1 som en definierande ekvation för funktionen ”f(” så
kan du beräkna f(0) = 1 och f(5) = 26.
Om du trycker på  visas en meny för registrering av den definierande
ekvationen av f(x) eller g(x) samt för inmatning av ”f(” eller ”g(”.

Obs!

• De definierande ekvationerna för f(x) och g(x) används också av f(x) och g(x) i Table-
läget. Mer information om Table-läget hittar du i ”Skapa en nummertabell” (sida
94).

Registrera en definierande ekvation
Exempel 1: För att registrera f(x) = x2 + 1
1. Tryck på , välj ikonen för Calculate-läget och tryck sedan på .
2. Tryck på  och välj sedan [Define f(x)].

• Då visas ekvationsinmatningsskärmen f(x).

3. Mata in x2 + 1.

1

4. Tryck på .
• Detta registrerar det uttryck du matar in och den skärm som visades

innan du tryckte på  i steg 2 i den här proceduren.
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Obs!

• En definierande ekvation kan registreras från vilken räknare som helst, utom
Distribution, Equation (Simul Equation / Polynomial), Inequality, Base-N, Ratio och
Math Box. Beroende på vilken skärm som visas i räknarläget (till exempel om en
menyskärm visas) kan det hända att menyn inte visas när du trycker på .

Utföra en beräkning genom att tilldela ett värde till
den registrerade definierande ekvationen

Exempel 2: För att tilldela värdet x = 3 till f(x), som du registrerade i
exempel 1
(Fortsätter från exempel 1)
1. Tryck på  och välj sedan [f(x)].

• Detta matar in f(.

2. Tilldela ett värde på 3 och utför sedan beräkningen.

3

Registrera en sammansatt funktion
Exempel 3: För att mata in f(x) så som definieras i exempel 1 i g(x) och
registrera g(x) = f(x) × 2 - x
(Fortsätter från exempel 1)
1. Tryck på  och välj sedan [Define g(x)].

• Då visas ekvationsinmatningsskärmen g(x).

2. Mata in f(x) × 2 - x.

* 2

* Om du trycker på  medan ekvationsinmatningsskärmen g(x) visas
så är det enda menyalternativet som visas [f(x)]. På samma sätt
så visas endast menyalternativet [g(x)] om du trycker på  medan
ekvationsinmatningsskärmen f(x) visas.

3. Tryck på .
• Detta registrerar den ekvation som du matar in och återgår till den

skärm som visas innan du startade den här åtgärden med steg 1.
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Obs!

• Operationen för att tilldela ett värde till x för g(x) och beräkna resultatet är densamma
som den under ”Utföra en beräkning genom att tilldela ett värde till den
registrerade definierande ekvationen” (sida 61). Observera dock att i stället för
att välja [f(x)] i steg 1, bör du välja [g(x)].

• Vid användning av exempel 3, matar du in f(x) i den definierande ekvationen för g(x).
Omvänt kan du också mata in g(x) i den definierande ekvationen för f(x). Mata dock
inte in g(x) i f(x) och f(x) i g(x) samtidigt. Om du gör detta så inträffar ett Circular
ERROR när du utför en beräkning med f(x) eller g(x).

Datalagring
Om du utför någon av åtgärderna nedan tas de definierade ekvationerna
som matats in för f(x) och g(x) bort.

• Tryck på 
• Använd SETTINGS-menyn för att växla till Input/Output-inställningen

mellan MathI*1 och LineI*2.
*1 MathI/MathO eller MathI/DecimalO
*2 LineI/LineO eller LineI/DecimalO

• Kör  – [Reset] > [Settings & Data] eller  – [Reset] > [Initialize All]
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Använda funktioner för QR
Code

Använda funktioner för QR Code
Din räknare kan visa QR Code-symboler som kan läsas av en smart
enhet.

Viktigt!

• Åtgärderna i det här avsnittet förutsätter att den smarta enhet som används har en QR
Code-läsare som kan läsa flera QR Code-symboler, och att den kan ansluta till nätet.

• Om du skannar en QR Code som visas av den här räknaren med en smart enhet så
får den smarta enheten åtkomst till CASIO:s webbplats.

Obs!

• QR Code visas på displayen när du trycker på (QR) när någon av skärmarna
nedan visas.
– HOME-skärmen
– SETTINGS-menyskärmen
– Felskärmar
– Skärmar för beräkningsresultat oavsett läge
– Tabellskärma oavsett läge
– Spreadscheet-lägets skärm
Mer information finns på CASIO:s webbplats (https://wes.casio.com).

Visa en QR Code
Exempel: För att visa QR Code för ett beräkningsresultat i räknarens
Calculate-läge och skanna den med en smart enhet
1. Gör en beräkning i Calculate-läget.
2. Tryck på (QR) för att visa QR Code.

• Siffrorna i displayens nedre högra hörn visar aktuellt QR Code-
nummer och totalt antal för QR Code-symboler. För att visa nästa
QR Code trycker du på  eller .

Obs!

• För att gå tillbaka till en tidigare QR Code trycker du på  eller  så många
gånger som behövs för att bläddra framåt tills den visas.

3. Använd en smart enhet för att skanna QR Code på räknarens skärm.
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• Mer information om hur du skannar en QR Code hittar du i
användardokumentationen till den QR Code-kodläsare du använder.

Om du upplever problem med att skanna en QR
Code

När QR Code visas ska du använda  och  för att justera
visningskontrasten QR Code. Denna kontrastjustering påverkar endast
visning av QR Code.

Viktigt!

• Beroende på vilken smart enhet och/eller QR Code-äsare som används kan du få
problem med att skanna QR Code-symboler som produceras av den här räknaren.

• När QR Code-inställningen i SETTINGS-menyn är Version 3 är de räknarlägen som
kan visa QR Code-symbolerna begränsade. Om du försöker visa en QR Code i ett
läge som inte har stöd för QR Code-visning så visas meddelandet Not Supported
(Version 3). De QR Code som produceras av den här inställningen är dock enklare att
skanna med en smart enhet.

• Mer information finns på CASIO:s webbplats (https://wes.casio.com).
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Använda räknarens lägen

Statistiska beräkningar
Statistics-läget beräknar olika statistiska värden baserat på data med en
variabel (x) eller parad variabel (x, y).

Allmän procedur för att utföra en statistisk
beräkning

1. Tryck på , välj ikonen för Statistics-läget och tryck sedan på .
2. I menyn som visas väljer du [1-Variable] (en variabel) eller [2-Variable]

(parad variabel), och trycker sedan på .
• Då visas statistikredigeraren.

En variabel

Parad variabel

3. Visa kolumnen Freq (frekvens) efter behov.
• Mer information hittar du i ”Freq-kolumnen (Frekvens)” (sida 66).

4. Mata in data.
• Mer information hittar du i ”Mata in data med statistikredigeraren”

(sida 66).
5. När du är klar med inmatningen trycker du på .

• Då visas menyn nedan.

En variabel
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Parad variabel

6. Välj menyalternativet för den åtgärd du vill utföra.
• Välj [1-Var Results], [2-Var Results] eller [Reg Results] för att visa

en lista över beräkningsresultat baserat på de data du angett. Mer
information finns i ”Visa resultat för statistiska beräkningar” (sida
69).

• För att visa en skärm för statistisk beräkning för att utföra beräkningar
baserat på indata väljer du [Statistics Calc]. Mer information finns i
”Använda skärmen för statistik beräkning” (sida 73).

Obs!

• För att gå tillbaka till statistikredigeraren från en skärm för statistisk beräkning trycker
du på  och sedan på .

Mata in data med statistikredigeraren
Statistikredigeraren visar en, två eller tre kolumner: en variabel (x), en
variabel och frekvens (x, Freq), parad variabel (x, y), parad variabel och
frekvens (x, y, Freq). Antal datarader som kan matas in beror på antalet
kolumner: 160 rader för en kolumn, 80 rader för två kolumner och 53 rader
för tre kolumner.

Viktigt!

• Alla data som för närvarande matas in i statistikredigeraren tas bort när du utför någon
av åtgärderna nedan.
– Växla den statistiska beräkningstypen mellan en variabel och parad variabel
– Ändra Frequency-inställningen i TOOLS-menyn

• Statistiska beräkningar kan ta lång tid när det finns ett stort antal datapunkter.

Freq-kolumnen (Frekvens)

Om du startar inställningen Frequency i TOOLS-menyn så visas även
en kolumn som är märkt Freq i statistikredigeraren. Du kan använda
Freq-kolumnen för att specificera frekvens (antalet gånger provet visas i
datagruppen) för varje provvärde.
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En variabel

Parad variabel

Visa Freq-kolumnen
1. När statistikredigeraren visas trycker du på  och väljer sedan

[Frequency] > [On].
2. Tryck på  för att återgå till Statistikredigeraren.

Dölja Freq-kolumnen
1. När statistikredigeraren visas trycker du på  och väljer sedan

[Frequency] > [Off].
2. Tryck på  för att återgå till Statistikredigeraren.

Regler för inmatning av exempeldata i statistikredigeraren

Data som du matar in infogas i cellen där markören är. Använd
markörknapparna för att flytta markören mellan celler.

   Markör

När du har matat in ett värde trycker du på . Detta registrerar värdet och
visar upp till sex av dess siffror i cellen.

Exempel 1: För att välja en parad variabel och mata in följande data:
(170, 66), (179, 75), (173, 68)
1. Tryck på , välj ikonen för Statistics-läget och tryck sedan på .
2. Välj [2-Variable] och tryck sedan på .
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3. Använd åtgärden nedan för att mata in data.

170 179 173
66 75 68

Obs!

• I statistikredigeraren kan du lagra värdet i en cell till en variabel. Om du till exempel
utför följande åtgärd medan skärmen i steg 3 visas ovan sparas 68 till variabel A:

 – [A=] > [Store]. Mer information om variabler hittar du i ”Variabler (A, B, C, D,
E, F, x, y, z)” (sida 35).

Redigera provdata

Ersätta data i en cell
I statistikredigeraren flyttar du markören till cellen som innehåller data du
vill redigera, ange det nya värdet och tryck sedan på .

Ta bort en rad
I statistikredigeraren flyttar du markören till den rad som du vill ta bort och
trycker sedan på .

Infoga en rad
1. I statistikredigeraren flyttar du markören till den rad som ska vara under

den rad som du vill infoga.
2. Utför följande åtgärd:  – [Edit] > [Insert Row].

Ta bort allt innehåll i statistikredigeraren
I statistikredigeraren utför du följande åtgärd:  – [Edit] > [Delete All].

Sortera data

Du kan sortera data från statistikredigeraren i stigande eller fallande
ordning för dess kolumnvärden för x, y eller Freq.

Viktigt!

• Observera att när du har ändrat datasorteringssekvensen så kan du inte återställa den
till den ursprungliga sekvensen.
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Exempel 2: För att sortera datainmatningen i Exempel 1 (sida 67) i
stigande ordning i x-kolumnen och sedan i fallande ordning i y-kolumnen
1. Använd proceduren i exempel 1 för att mata in data.

2. Sortera data i stigande ordning i x-kolumnen.

 – [Sort] > [x Ascending]

3. Sortera data i fallande ordning i y-kolumnen.

 – [Sort] > [y Descending]

Visa resultat för statistiska beräkningar

Visa resultat för statistiska beräkningar med en variabel

1-Var Results-skärmen visar en lista över olika statistiska värden (t.ex.
medelvärde och standardavvikelse för populationen) som beräknas utifrån
data för en variabel. I det här avsnittet beskrivs den åtgärd som krävs för
att visa 1-Var Results-skärmen.

Exempel 3: För att mata in data nedan och visa resultat för statistiska
beräkningar med en variabel

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1. Tryck på , välj ikonen för Statistics-läget och tryck sedan på .
2. Välj [1-Variable] och tryck sedan på .

• Då visas statistikredigeraren.
3. Tryck på  och välj sedan [Frequency] > [On].

• Tryck på  för att återgå till Statistikredigeraren.
4. Mata in data i x-kolumnen.

1 2 3 4 5 6 7 8 9 10

5. Mata in data i Freq-kolumnen.
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2 2 2 2 3 4 2

6. Tryck på .

7. Välj [1-Var Results] och tryck sedan på .
• Då visas 1-Var Results-skärmen.

 (eller )

 (eller )

• Information om betydelsen för de variabler som visas på 1-Var
Results-skärmen finns i ”Lista över statistiska värdevariabler och
statistiska beräkningsfunktioner” (sida 76).

8. Tryck på  eller  för att återgå till statistikredigeraren.

Visa resultat för statistiska beräkningar med parad variabel

2-Var Results-skärmen visar en lista över olika statistiska värden (t.ex.
medelvärde och standardavvikelse för populationen) som beräknas utifrån
parade variabeldata. I det här avsnittet beskrivs den åtgärd som krävs för
att visa 2-Var Results.

Exempel 4: För att mata in data nedan och visa resultat för statistiska
beräkningar med parad variabel

x 1,0 1,2 1,5 1,6 1,9 2,1 2,4 2,5 2,7 3,0
y 1,0 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 2,0

1. Tryck på , välj ikonen för Statistics-läget och tryck sedan på .
2. Välj [2-Variable] och tryck sedan på .

• Då visas statistikredigeraren.
3. Mata in data i x-kolumnen.
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1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. Mata in data i y-kolumnen.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5. Tryck på .

6. Välj [2-Var Results] och tryck sedan på .
• Då visas 2-Var Results-skärmen.

 (eller )

 (eller )

 (eller )

• Information om betydelsen för de variabler som visas på 2-Var
Results-skärmen finns i ”Lista över statistiska värdevariabler och
statistiska beräkningsfunktioner” (sida 76).

7. Tryck på  eller  för att återgå till statistikredigeraren.

Visa resultat för regressionsberäkningar

Reg Results-skärmen visar en lista för regressionsberäkningsresultat
(koefficienter för regressionsekvationer) baserat på data för parad
variabel. I det här avsnittet beskrivs den åtgärd som krävs för att visa
Reg Results-skärmen.
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Exempel 5: För att använda inmatningen av parad variabel från Exempel
4 (sida 70) och visa resultaten av de två regressionsberäkningarna som
visas nedan
• Regressionsekvationen y = a + bx har koefficienterna (a, b) och

korrelationskoefficienten (r) när linjär regression utförs på data
• Regressionsekvationen y = a + bx + cx2 har koefficienterna (a, b, c) när

kvadratisk regression utförs på data

Obs!

• För information om vilka regressionsberäkningstyper som stöds av Statistics-läget, se
”Regressionstyplista som stöds” (sida 72).

1. Utför steg 1 till 5 för proceduren i Exempel 4 (sida 70).
2. Välj [Reg Results] och tryck sedan på .

• Då visas regressionstypmenyn.

3. Välj [y=a+bx] och tryck sedan på .
• Då visas Reg Results-skärmen för linjär regression.

4. Tryck på  eller  för att återgå till statistikredigeraren.
5. Tryck på  och välj sedan [Reg Results] > [y=a+bx+cx2].

• Då visas Reg Results-skärmen för kvadratisk regression.

6. Tryck på  eller  för att återgå till statistikredigeraren.
• Information om betydelsen för de variabler som visas på Reg

Results-skärmen finns i ”Lista över statistiska värdevariabler och
statistiska beräkningsfunktioner” (sida 76).

Regressionstyplista som stöds

Regressionstyp
Regressionsekvation

(menyalternativet för regressionstyp)

Linjär regression y = a + bx
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Kvadratisk regression y = a + bx + cx2

Logarirmregression y = a + b･ln(x)

e exponentiell regression y = a･e^(bx)

ab exponentiell regression y = a･b^x

Potensregression y = a･x^b

Inverterad regression y = a + b/x

Använda skärmen för statistik beräkning
Du kan använda skärmen för statistisk beräkning för att hämta individuella
statistiska värden och använda värdena i beräkningar.

Skärm utan indata för beräkningsuttryck

Exempelberäkning

För att hämta ett statistiskt värde använder du en variabel som
representerar det statistiska värde du vill hämta (till exempel: x
medelvärde: x, x standardavvikelse för populationen: σx, x maxvärde:
max(x) och så vidare). För mer information om dessa variabler, se ”Lista
över statistiska värdevariabler och statistiska beräkningsfunktioner”
(sida 76).

Visa skärmen för statistiska beräkningar

En variabel
1. När statistikredigeraren visas trycker du på .
2. I menyn som visas väljer du [Statistics Calc] och trycker sedan på .
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Parad variabel
1. När statistikredigeraren visas trycker du på .
2. I menyn som visas väljer du [Statistics Calc] och trycker sedan på .

• Detta visar menyn regressionstyp (se ”Regressionstyplista som
stöds” (sida 72)).

3. I menyn väljer du den regressionstyp du vill använda och trycker sedan
på .

• I exemplet ovan använder du den visade menyn för att välja [y=a+bx]
(linjär regression).

För att gå tillbaka till statistikredigeraren från en skärm för statistisk
beräkning
Trycker du på  och sedan på .

Beräkningsexempel med skärmen för statistiska beräkningar

Exempel 6: För att bestämma summan av exempeldata (Σx) och
medelvärdet (x) för indata för en variabel i Exempel 3 (sida 69)
1. Utför steg 1 till 6 för proceduren i Exempel 3 (sida 69).
2. Välj [Statistics Calc] och tryck sedan på .

3. Beräkna summan av provdata (Σx).

 – [Statistics] > [Summation] > [Σx]

4. Beräkna medelvärdet (x).

 – [Statistics] >
[Mean/Var/Dev...] > [x]
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Obs!

• För att visa 1-Var Results-skärmen från skärmen för statistiska beräkningar ovan
trycker du på  och väljer sedan [1-Var Results]. Om du vill återgå till skärmen för
statistisk beräkning från 1-Var Results- skärmen trycker du på  eller .

Exempel 7: För att bestämma koefficienterna (a, b) och
korrelationskoefficienten (r) för den linjära regressionsekvationen y = a
+ bx baserat på den parade variabeldatainmatningen som matats in i
Exempel 4 (sida 70)
1. Utför steg 1 till 5 för proceduren i Exempel 4 (sida 70).
2. Välj [Statistics Calc] och tryck sedan på .

• Då visas regressionstypmenyn.

3. Välj [y=a+bx] och tryck sedan på .

4. Bestämmer koefficienterna (a, b) och korrelationskoefficienten (r) för
regressionsekvationen y = a + bx.

 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• Om du vill välja en annan regressionstyp trycker du på  och väljer
[Select Reg Type]. Då visas regressionstypmenyn från steg 2.

För att visa 2-Var Results-skärmen från en skärm för statistisk
beräkning
Tryck på  och välj sedan [2-Var Results].
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Om du vill visa Reg Results-skärmen från en skär för statistisk
beräkning
Tryck på  och välj sedan [Reg Results].

Lista över statistiska värdevariabler och statistiska
beräkningsfunktioner

Du kan använda CATALOG-menyn för att hämta variabler som
representerar statistiska värden och funktioner som används för statistiska
beräkningar.

Obs!

• För statistiska beräkningar med en variabel är variablerna markerade med en asterisk
(*) tillgängliga.

• Mer information om beräkningsformeln som används för varje variabel och kommando
hittar du i ”Formel för statistisk beräkning” (sida 79).

 – [Statistics] > [Summation]
Σx*, Σy ...... summa av provdata
Σx2*, Σy2 ...... summa av kvadrater av provdata
Σxy ...... summa av produkter av x-data och y-data
Σx3 ...... summa av kuber av x-data
Σx2y ...... summa av (x-datakvadrater × y-data)
Σx4 ...... summa av bikvadrater för x-data

 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... medelvärde
σ2

x*, σ2
y ...... populationsvarians

σx*, σy ...... standardavvikelse för population
s2

x*, s2
y ...... provvarians

sx*, sy ...... standardavvikelse för prov
n* ...... antal objekt

 – [Statistics] > [Min/Max/Quartile] (Endast data med en variabel)
min(x)* ...... minsta värde
Q1* ...... första kvartil
Med* ...... median
Q3* ...... tredje kvartil
max(x)* ...... maxvärde

 – [Statistics] > [Norm Dist] (Endast data med en variabel)
P(*, Q(*, R(*, t* ...... Funktioner för att utföra normala
fördelningsberäkningar. Mer information om de här funktionerna finns
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i ”Utföra normala distributionsberäkningar (endast data med en
variabel)” (sida 77).

 – [Statistics] > [Min/Max] (endast data med parad variabel)
min(x), min(y) ...... mista värde
max(x), max(y) ...... maxvärde

 – [Statistics] > [Regression] (endast data med parad variabel)

För kvadratisk regression
a, b, c ...... regressionskoefficienter för kvadratisk regression
x̂1, x̂2 ...... Funktioner för att bestämma x1 och x2 uppskattade värden för
ett inmatat y-värde. Som argument matar du in värdet y omedelbart före
funktionen x̂1 eller x̂2.
ŷ ...... Funktion för att bestämma det uppskattade y-värdet för ett inmatat
x-värde. Som argument matar du in värdet x omedelbart före denna
funktion.

För icke-kvadratisk regression
a, b ...... regressionskoefficienter
r ...... korrelationskoefficient
x̂ ...... Funktion för att bestämma det uppskattade x-värdet för ett inmatat
y-värde. Som argument matar du in värdet y omedelbart före denna
funktion.
ŷ ...... Funktion för att bestämma det uppskattade y-värdet för ett inmatat
x-värde. Som argument matar du in värdet x omedelbart före denna
funktion.
Du hittar ett exempel på operationen för att bestämma uppskattade
värden i ”Beräkna uppskattade värden (data med parad variabel)”
(sida 78).

Utföra normala distributionsberäkningar (endast data med en
variabel)

När du väljer en beräkning med en statistisk variabel kan du utföra normal
distributionsberäkning med hjälp av funktionerna i menyn nedan som visas
när du trycker på  och sedan väljer [Statistics] > [Norm Dist].

P(, Q(, R( ... De här funktionerna använder argumentet t och bestämmer
sannolikheten för normal normalfördelning enligt bilden nedan.
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t ...... Den här funktion föregås av argumentet x. Den beräknar
standardvariatet för datavärde x med hjälp av medelvärdet (x)
och standardavvikelsen för populationen (σx) för datainmatning med
statistikredigeraren.

Exempel 8: För indata med en variabel i Exempel 3 (sida 69) bestämer
du den normaliserade varianten när x = 2 och P(t) vid den punkten.
1. Utför steg 1 till 6 för proceduren i Exempel 3 (sida 69).
2. Välj [Statistics Calc] och tryck sedan på .

3. Beräkna den normaliserade varianten när x = 2.

2
 – [Statistics] > [Norm Dist] > [ t]

4. Beräkna P(t).

 – [Statistics] > [Norm Dist] > [P(]

Beräkna uppskattade värden (data med parad variabel)

Baserat på regressionsekvationen som erhålls genom statistiska
beräkningar med parad variabel så kan y beräknas för ett givet x-värde.
Motsvarande x-värde (två värden, x1 och x2, för kvadratisk regression) kan
också beräknas för ett y-värde i regressionsekvationen.

Exempel 9: För att bestämma det uppskattade värdet för y när x = 5,5
i regressionsekvationen som beräknats genom linjär regression av data
som inmatats i Exempel 4 (sida 70)
1. Utför steg 1 till 5 för proceduren i Exempel 4 (sida 70).
2. Välj [Statistics Calc] och tryck sedan på .

• Då visas regressionstypmenyn.
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3. Välj [y=a+bx] och tryck sedan på .

4. Mata in x-värdet (5,5), och mata sedan in funktionen ”ŷ” för att
bestämma det uppskattade värdet för y.

5 5
 – [Statistics] > [Regression] > [ŷ]

5. Tryck på .

Formel för statistisk beräkning

Formel för statistiska beräkningar med en variabel

Formel för statistiska beräkningar med parad variabel

Formel för regressionsberäkning

Linjär regression (y = a + bx)
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Kvadratisk regression (y = a + bx + cx2)

Logaritsmregression (y = a + b･ln(x))
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e Exponentiell regression (y = a･e^(bx))

ab Exponentiell regression (y = a･b^x)

Potensregression (y = a･x^b)

Inverterad regression (y = a + b/x)
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Fördelningsberäkningar
I Distribution-läget kan du få sannolikhetsvärdet genom att välja
fördelningstyp och ange olika parametrar.* Beräkningstyper för körbar
distribution visas i tabellen nedan.

Fördelningsberäkningstyp Menyalternativ

Binomial sannolikhet Binomial PD

Binomial kumulativ sannolikhet Binomial CD

Normal sannolikhetstäthet Normal PD

Normal kumulativ sannolikhet Normal CD

Omvänd normal kumulativ fördelning* Inverse Normal

Poissonsannolikhet Poisson PD

Poisson-kumulativ sannolikhet Poisson CD

* Inverse Normal utför inverterad beräkning för att bestämma datavärdet
(xInv) från ett sannolikhetsvärde (Area).

Allmän procedur för att utföra en
fördelningsberäkning

Exempel: För att beräkna binomial kumulativ sannolikhet för x-data {2, 3,
4, 5} närN (antal försök) = 5 och p (sannolikhet för framgång) = 0,5

1. Tryck på , välj ikonen för Distribution-läget och tryck sedan på .
• Då visas distributionsberäkningsmenyn.

2. I menyn väljer du en distributionsberäkningstyp.
• Här vill vi beräkna binomial kumulativ sannolikhet. Välj [Binomial CD]

och tryck sedan på .
3. I menyn som visas väljer du en inmatningsmetod för data (x).
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[List] ... Välj inmatning av flera x-dataobjekt samtidigt. Om du väljer det
här menyalternativet visas listskärmen.

[Variable] ... Välj att mata in ett enda x-dataobjekt. Om du väljer det här
alternativet visas parameterinmatningsskärmen.

• Här vill vi mata in flera x-dataobjekt samtidigt, välj [List] och tryck
sedan på .

4. På listskärmen matar du in x-data {2, 3, 4, 5}.

2 3 4 5

5. Tryck på .
• Då visas Binomial CD-skärmen för parameterinmatning.

6. Mata in värdena för parametrarna (N = 5, p = 0,5).

5 0 5

• Vilka parametrar som kräver datainmatning beror på vilken
beräkningstyp du valde i steg 2 i den här proceduren. Mer information
finns i ”Parameterlista” (sida 84).

7. När du har matat in värden för alla variabler väljer du [Execute] och
trycker sedan på .
• Då visas beräkningsresultatskärmen.

• Om du valde [List] i steg 3, så visas nu beräkningsresultat (P-kolumn)
på listskärmen. Mer information finns i ”Listskärm” (sida 85).

• Om du utför någon redigering (se ”Redigera innehållet på
listskärmen” (sida 85)) på listskärmen medan beräkningsresultat
visas så rensas alla beräkningsresultat. Listskärmen återgår till sitt
läge i steg 4 (inmatning av data slutförd) för den här proceduren.

• Ett felmeddelande visas om inmatat värdet ligger utanför det
tillåtna intervallet. ERROR visas i P-kolumnen på skärmen för
beräkningsresultat när värdet för motsvarande data ligger utanför det
tillåtna intervallet.

83



• Om du trycker på  medan skärmen för beräkningsresultat visas
återgår den till skärmen för parameterinmatning.

Obs!

• Om du valde Normal PD, Normal CD eller Inverse Normal i steg 2 ovan så kommer
inmatningsmetoden för (x)-data alltid vara Variable (enkel x-dataobjektinmatning). På
grund av detta visas inte menyn i steg 3 just nu.

• Om inmatningsmetoden för (x)-data är Variable så lagras beräkningsresultatet i ANS-
minnet.

• Distributionsberäkningens noggrannhet är upp till 6 signifikanta siffror.

Parameterlista
Listan nedan visar innebörden av de symboler som visas på skärmen för
parameterinmatning.

Binomial PD, Binomial CD
x … data
N … antal försök
p … sannolikhet för framgång (0 ≤ p ≤ 1)

Normal PD
x … data
μ … populationsmedelvärde
σ … standardavvikelse för population (σ > 0)

Normal CD
Lower … lägre gräns
Upper … övre gräns
μ … populationsmedelvärde
σ … standardavvikelse för population (σ > 0)

Inverse Normal
Area … sannolikhetsvärde (0 ≤ Area ≤ 1)
μ … populationsmedelvärde
σ … standardavvikelse för population (σ > 0)
(Svansen är alltid åt vänster.)

Poisson PD, Poisson CD
x … data
λ … medelvärde
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Obs!

• Det sista värdet för varje parameternamn behålls oavsett vilken inmatningsskärm som
används. Till exempel om du anger ett värde för N på parameterinmatningsskärmen
Binomial PD så ändras även värdet för N på parameterinmatningsskärmen Binomial
CD.

• De värden du anger för varje parameter behålls så länge du inte utför någon av
följande åtgärder:  – [Reset] > [Settings & Data] eller  – [Reset] > [Initialize All].

Listskärm
Du kan använda listskärmen för att mata in upp till 45 x-datapunkter.
Beräkningsresultat visas också på listskärmen.

(1) Fördelningsberäkningstyp
(2) Värde vid aktuell markörposition
(3) Data (x)
(4) Beräkningsresultat (P)

Obs!

• På listskärmen kan du lagra värdet i en cell till en variabel. Om du till exempel utför
följande åtgärd medan ovanstående skärm visas sparas 1 till variabel A:  – [A=] >
[Store]. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x, y, z)”
(sida 35).

• Om du utför någon av åtgärderna nedan tas alla x-datainmatningar bort från
listskärmen.
– Gå tillbaka till HOME-skärmen och starta ett annat räknarläge
– Köra [Delete All] (se ”Ta bort allt innehåll på listskärmen” (sida 86).)
– Köra  – [Reset] > [Settings & Data] eller  – [Reset] > [Initialize All]

Redigera innehållet på listskärmen

Ersätta x-data i en cell

På listskärmen flyttar du markören till cellen som innehåller data du vill
redigera, ange det nya värdet och trycker sedan på .

Ta bort en rad

På listskärmen flyttar du markören till den rad som du vill ta bort och
trycker sedan på .
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Infoga en rad

1. På listskärmen flyttar du markören till den rad som ska vara under den
rad som du vill infoga.

2. Utför följande åtgärd:  – [Edit] > [Insert Row].
• Detta infogar en rad med 0 indata som det ursprungliga värdet.

3. Mata in data.

Ta bort allt innehåll på listskärmen

På listskärmen utför du följande åtgärd:  – [Edit] > [Delete All].

Beräkningsexempel
För att beräkna den normala sannolikhetstätheten när x = 36, μ = 35, σ = 2
1. Tryck på , välj ikonen för Distribution-läget och tryck sedan på .
2. I menyn för distributionsberäkningstyp som visas väljer du [Normal PD]

och trycker sedan på .
• Då visas skärmen för parameterinmatning Normal PD.

3. Mata in värdena för parametrarna (x = 36, μ = 35, σ = 2).

36 35 2

4. Tryck på .

• Om du trycker på  en gång till eller trycker på  eller  så
återgår du till parameterskärmen i steg 3 i den här proceduren.

• Du kan lagra det beräkningsresultat som visas för tillfället i en
variabel. Om du till exempel utför följande åtgärd medan skärmen i
steg 4 visas ovan sparas beräkningsresultatet till variabel A:  – [A=]
> [Store]. Mer information om variabler hittar du i ”Variabler (A, B, C,
D, E, F, x, y, z)” (sida 35).
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Använda kalkylblad
Med Spreadsheet-läget kan du utföra beräkningar med hjälp av ett
kalkylblad med 45 rader och 5 kolumner (cell A1 till E45).
För att utföra åtgärderna i det här avsnittet startar du först Spreadsheet-
läget. Tryck på , välj ikonen för Spreadsheet-läget och tryck sedan på

. Då visas kalkylbladsskärmen.

(1) Radnummer (1 till 45)
(2) Kolumnbokstäver (A till E)
(3) Markör: Visar vilken cell som för närvarande är vald. Radnumret

och kolumnbokstaven för den markerade cellradnumren och
kolumnbokstäverna visas i mörkgrått.

(4) Redigeringsruta: Visar innehållet i cellen där markören för
närvarande finns.

Viktigt!

• Varje gång du stänger av räknaren eller trycker på tangenten  så rensas allt som
matats in i kalkylbladet.

Mata in och redigera cellinnehåll
Du kan ange en konstant eller en formel i varje cell.
Konstanter: En konstant ges ett fast värde så snart du slutfört
inmatningen. En konstant kan vara antingen ett numeriskt värde eller
ett beräkningsuttryck (t.ex. 7+3, sin30, A1×2, osv.) utan likhetstecken (=)
framför.
Formler: En formel som börjar med ett likhetstecken (=), till exempel =A1
x 2, körs som den är skriven.

Obs!

• Högst 49 byte kan matas in i en cell (antal byte innan inmatningen bekräftas genom att
trycka på ) som redigeras. Nedan visas hur antalet byte räknas.
– Siffror, variabler och symboler: 1 byte per tecken
– Kommandon, funktioner: 1 byte var

Varje kommando eller funktion räknas som en byte. Till exempel är följande en byte:
√ (, Sum(.
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• Antalet byte som förbrukas efter att inmatningen bekräftats visas nedan, beroende på
innehållet i varje cell.
– Konstanter: 14 byte, oavsett antalet inmatade siffror*
– Formler: Antal indatabyte (max 49 byte) + 15 byte
* Om du anger en konstant med 11 eller fler signifikanta siffror omvandlas värdet till 10

signifikanta siffror när inmatningen bekräftas.
Exempel: Om du anger 12345678915 (11 siffror) konverteras värdet till 1,234567892
x 1010 (10 siffror).

För att visa återstående inmatningskapacitet

Tryck på , välj [Available Memory] och tryck sedan på .

Mata in en konstant och en formel i en cell
Exempel 1: I cellerna A1, A2 och A3 matar du in konstanterna 7×5, 7×6
och A2+7, i den ordningen. Mata sedan in följande formel i cell B1: =A1+7.
1. Flytta markören till cell A1.
2. Utför tangentåtgärderna nedan.

7 5 7 6 (A) 7

3. Flytta markören till cell B1 och utför sedan tangentåtgärderna nedan.

(=) (A) 7

Obs!

• På kalkybladsskärmen kan du lagra värdet i en cell till en variabel. Om du till
exempel utför följande åtgärd medan skärmen i steg 3 visas kommer 42 att lagras
(beräkningsresultatet för formeln som matats in i cell B1) till variabel A:  – [A=]
> [Store]. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x, y, z)”
(sida 35).

• Du kan ange om en formel i redigeringsrutan ska visas som den är eller som dess
beräkningsresultatvärde. Se ”Inställningsobjekt för Spreadsheet-läget” (sida 93).

Redigera befintliga celldata

1. Flytta markören till den cell vars innehåll du vill redigera och tryck sedan
på .
• Istället för att trycka på , kan du välja att istället utföra åtgärden

nedan.
 – [Edit Cell]
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• Cellinnehållet i redigeringsrutan ändras från höger- till
vänsterjustering. En textmarkör (|) visas i redigeringsrutan så att du
kan redigera innehållet.

2. Använd  och  för att flytta textmarkören runt innehållet i cellen och
redigera dem efter behov.

3. För att slutför och tillämpa ändringarna trycker du på .

Ange ett cellreferensnamn med kommandot Grab

Kommandot Grab kan användas i stället för ett manuellt referensnamn
(såsom A1) ocg du kan använda en tangentkombination för att välja och
mata in i en cell som du vill referera till.

Exempel 2: Fortsätt på Exempel 1 och mata sedan in följande formel i cell
B2: =A2+7.
1. Flytta markören till cell B2.
2. Utför åtgärden nedan.

(=)  – [Spreadsheet] > [Grab]

7

Cellrelativa och absoluta referenser
Det finns två typer av cellreferens: relativ och absolut.

Relativ cellreferens

Cellreferensen (A1) i en formel som =A1+7 är en relativ referens, vilket
innebär att den ändras beroende i vilken cell formeln finns. Om t.ex.
formeln =A1+7 ursprungligen finns i cell B1 kommer kopiering och
inklistring i cell C3 leda till att resultera i att =B3+7 matas in i cell C3.
Eftersom kopierings- och inklistringsfunktionen flyttar formeln en kolumn
(B till C) och till två rader (1 till 3) flyttas A1-referensen i formeln en kolumn
och två rader till B3. Om resultatet av en kopierings- och inklistringsåtgärd
leder till att ett relativt cellreferensnamn ändras till något som ligger utanför
kalkylbladscellernas område så visas tillämplig kolumnbokstav och/eller
radnumret med ett frågetecken (?), och ERROR visas som celldata.
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Absolut cellreferens

Om du vill att raden eller kolumnen, eller både raden och kolumndelarna
i ett cellreferensnamn, ska förbli desamma oavsett var du klistrar in dem
måste du skapa ett absolut cellreferensnamn. För att skapa en absolut
cellreferens placerar du ett dollartecken ( ) framför kolumnnamnet och/
eller radnumret. Du kan använda en av tre olika absoluta cellreferenser:
absolut kolumn med relativ rad ( A1), relativ kolumn med absolut rad
(A 1) eller absolut rad och kolumn ( A 1).

Mata in symbolen för absolut cellreferens ( )

När du skriver in en formel i en cell trycker du på  och väljer sedan
[Spreadsheet] > [ ].

För att klippa ut och klistra in kalkylbladsdata

1. Flytta markören till den cell vars data du vill klippa ut.
2. Tryck på , välj [Cut & Paste] och tryck sedan på .

• Detta öppnar viloläge för inklistring. För att avbryta viloläge för
inklistring trycker du på  eller .

3. Flytta markören till den cell där du vill klistra in data som du precis klippt
ut och tryck sedan på .
• Om du klistrar in data samtidigt tas data bort från cellen där du utförde

urklipp och viloläget för inklistring avbryts då automatiskt.

Obs!

• Vi användning av åtgärden klippa ut och klistra in ändras inte cellreferenser när de
klistras in, oavsett om de är relativa eller absoluta.

För att kopiera och klistra in kalkylbladsdata

1. Flytta markören till den cell vars data du vill kopiera.
2. Tryck på , välj [Copy & Paste] och tryck sedan på .

• Detta öppnar viloläge för inklistring. För att avbryta viloläge för
inklistring trycker du på  eller .

3. Flytta markören till den cell där du vill klistra in data som du precis
kopierat och tryck sedan på .
• Viloläget för inklistring förblir aktiverat tills du trycker på  eller  så

att du kan klistra in de kopierade data till andra celler om du vill.
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Obs!

• När du kopierar innehållet i en cell som innehåller en formel med en relativ referens
ändras den relativa referensen beroende på placeringen av cellen där innehållet
klistras in.

Ta bort inmatad data från en specifik cell

Flytta markören till den cell vars innehåll du vill ta bort och tryck sedan på
.

Ta bort innehållet i alla celler i ett kalkylblad

Tryck på , välj [Delete all] och tryck sedan på .

Använda specialkommandon för Spreadsheet-
läget

I Spreadsheet-läget kan kommandona nedan användas i formler eller
konstanter. De här kommandona finns på menyn som visas när du trycker
på  och sedna väljer [Spreadsheet].

Min(
Returnerar det minsta av värdena i ett angivet cellområde.
Syntax: Min(första cell:sista cell)

Max(
Returnerar det största av värdena i ett angivet cellområde.
Syntax: Max(första cell:sista cell)

Mean(
Returnerar genomsnittet för värdena i ett angivet cellområde.
Syntax: Mean(första cell:sista cell)

Sum(
Returnerar summan av värdena i ett angivet cellområde.
Syntax: Sum(första cell:sista cell)

Exempel 3: Fortsätt från exempel 1 och mata i formeln =Sum(A1:A3) för
att beräknar summan av cellerna A1, A2 och A3 i cell A4.
1. Flytta markören till cell A4.
2. Mata in =Sum(A1:A3).
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(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3. Tryck på .

Gruppera inmatning av samma formel eller
konstant i flera celler

Du kan använda procedurerna i det här avsnittet för att mata in samma
formel eller konstant i en serie av celler. Använda kommandot Fill Formula
för att lägga in en formel satsvis, eller Fill Value för att mata in en konstant
satsvis.

Obs!

• Om den ingående formeln eller konstanten innehåller en relativ referens så matas
denna in i enlighet med den övre vänstra cellen i det angivna området. Om den
ingående formeln eller konstanten innehåller en absolut referens så matas den
absoluta referensen in i alla celler i det angivna området.

Om du vill mata in samma formel satsvis i en serie av celler

Exempel 4: Fortsätt från exempel 1 och mata satsvis in en formel i
cellerna B1, B2 och B3 som ska fördubbla cellens värde till vänster och
sedan subtrahera 3.
1. Flytta markören till cell B1.
2. Tryck på , välj [Fill Formula] och tryck sedan på .

• Då visas Fill Formula-skärmen.
3. På raden Form matar du in formeln =2A1-3: 2 (A) 3 .

• Du behöver inte mata in likhetstecken (=) i början.
4. På raden Range anger du B1:B3 som intervall för satsinmatningen.

5. För att verkställa inmatningen trycker du på .
• Detta matar in =2A1-3 i cellen B1, =2A2-3 i cellen B2 och =2A3-3 i

cellen B3.
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Om du vill mata in samma konstant satsvis i en serie av celler

Exempel 5: Fortsätt från exempel 4 och mata satsvis in en värden i
cellerna C1, C2 och C3 som är tre gånger värdena cellerna på dess
vänstra sida.
1. Flytta markören till cell C1.
2. Tryck på , välj [Fill Value] och tryck sedan på .

• Då visas Fill Value-skärmen.
3. På Value-raden matar du in konstanten B1×3: (B) 3 .
4. På Range-raden anger du C1:C3 som intervall för satsinmatningen.

5. För att verkställa inmatningen trycker du på .
• Detta matar in värdena för varje beräkningsresultat i cellerna C1, C2

och C3.

Inställningsobjekt för Spreadsheet-läget
Inställningsalternativen nedan finns på menyn TOOLS.◆ indikerar den ursprungliga standardinställningen.

Auto Calc
Anger om formler ska beräknas om automatiskt.
On◆: Aktiverar automatisk omberäkning.
Off: Avaktiverar automatisk omberäkning.

Show Cell
Anger om en formel i redigeringsrutan ska visas som den är eller som
dess beräkningsresultatvärde.
Formula◆: Visar formeln som den är.
Value: Visar formelns beräkningsresultatvärde.
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Auto Calc och Recalculate
Auto Calc är ett inställningsobjekt på TOOLS-menyn (se
”Inställningsobjekt för Spreadsheet-läget” (sida 93)).
Med Spreadsheet-läget i den ursprungliga standardinställningen (Auto
Calc: On) så räknas formlerna i en cell om automatiskt varje gång
cellinnehållet redigeras. Beroende på innehållet i kalkylbladet kan
automatisk omberäkning ta lång tid att genomföra. När Auto Calc är
inaktiverad (Off), måste du utföra omberäkning manuellt efter behov.

För att utföra omberäkning manuellt

Tryck på , välj [Recalculate] och tryck sedan på .

Obs!

• Även om Auto Calc-inställningen är On så ska du köra [Recalculate] i de fall som
anges nedan.
– När menyn SETTINGS används för att ändra Angle Unit-inställningen
– När en cell innehåller en formel med funktionen ”f(” eller ”g(” och motsvarande

definierande ekvation (f(x) eller g(x)) uppdateras
– När en cell innehåller en formel som använder en variabel och motsvarande variabel

uppdateras

Skapa en nummertabell
Du kan använda Table-läget för att skapa en nummertabell baserat på de
definierade ekvationer som är registrerade för funktionerna f(x) och g(x).

Allmän procedur för att skapa en nummertabell

Exempel: För att generera en nummertabell för funktionerna f(x) = x2 + 1
2

och g(x) = x2 - 1
2  för intervallet -1 ≤ x ≤ 1, ökat i steg om 0,5

1. Tryck på , välj ikonen för Table-läget och tryck sedan på .
• Då visas skärmen för nummertabellen.
• Om en definierande ekvation inte är registrerad för ena eller båda av

f(x) och g(x) och data vid markörens urvalsposition är tomma visas ett
meddelande längst ned på skärmen som indikerar att en definierande
ekvation inte är registrerad.
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2. Konfigurera inställningar för att generera en nummertabell från två
funktioner.
(1) Tryck på  och välj sedan [Table Type] > [f(x)/g(x)].
(2) Tryck på .
• Mer information om inställningar hittar du i ”Maximalt antal rader i en

nummertabell enligt Table Type” (sida 96).
3. Registrera en definierande ekvation för f(x).

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

(Skärmen omedelbart innan du tryckte på )

4. Registrera en definierande ekvation för g(x).

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(Skärmen omedelbart innan du tryckte på )

• Du kan också använda  för att registrera ett definierande uttryck.
Mer information hittar du i ”Definiera registrering av ekvation” (sida
96).

5. Konfigurera inställningen för nummertabellintervall.

 – [Table Range]
((-))1 1 0 5

6. Tryck på .
• Då visas resultaten på nummertabellskärmen.

• Vid nummertabellgenerering ändras innehållet i variabel x.

Obs!

• På nummertabellskärmen kan du lagra värdet i en cell till en variabel. Om du till
exempel utför följande åtgärd medan skärmen i steg 6 visas ovan sparas -1 till
variabel A:  – [A=] > [Store]. Mer information om variabler hittar du i ”Variabler
(A, B, C, D, E, F, x, y, z)” (sida 35).
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Maximalt antal rader i en nummertabell enligt Table
Type

Du kan konfigurera skärminställningar för nummertabeller för att visa
kolumner för både f(x) och g(x), eller för den ena av dessa. För att ställa in
detta använder du menyn som visas när du trycker på  – [Table Type]
när nummertabellskärmen visas.

f(x)/g(x) ... Visa både kolumnerna f(x) och g(x) (ursprunglig
standardinställning)
f(x) ... Visa endast f(x)-kolumnen
g(x) ... Visa endast g(x)-kolumnen

Det maximala antalet rader i den genererade nummertabellen beror
på Table Type-inställningen. Upp till 45 rader stöds för f(x)- eller g(x)-
inställningen, samtidigt som 30 rader stöds för f(x)/g(x)-inställningen.

Definiera registrering av ekvation
Du kan registrera definierande ekvationer på två sätt för f(x) och g(x).
• När Table-lägets nummertabellskärm visas kan du registrera en ekvation

genom att trycka på 
 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• När Table-lägets nummertabellskärm visas, eller när du använder
något annat räknarläge, utom Distribution, Equation (Simul Equation/
Polynomial), Inequality, Base-N, Ratio och Math Box, kan du registrera
en ekvation genom att trycka på 

 – [Define f(x)]
 – [Define g(x)]

Samma registreringsskärm för f(x)- och g(x)-ekvationer visas oavsett
vilken av de två ovanstående åtgärderna som används för att registrera
definierande ekvationer.

Obs!

• Mer information om operationer som använder  hittar du i ”Registrera och
använda definierande ekvationer för f(x) och g(x)” (sida 60).
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Redigera skärmdata för nummertabell

Ta bort en rad

1. På nummertabellskärmen flyttar du markören till den rad som du vill ta
bort.

2. Tryck på .

Infoga en rad

1. På nummertabellskärmen flyttar du markören till den rad som ska vara
under den rad som du vill infoga.

2. Utför följande åtgärd:  – [Edit] > [Insert Row].

Ta bort allt innehåll på nummertabellskärmen

På nummertabellskärmen utför du följande åtgärd:  – [Edit] > [Delete
All].

För att ändra värdet i en cell i kolumn x

Du kan ändra värdet i den markerade x-cellen. Om du ändrar x-värdet
uppdateras f(x)- och g(x)-värdena på samma rad i enlighet med detta.

Mata in ett värde i den markerade x-kolumncellen med: {värde
för cellen ovanför} +/- {stegvärde}

Om det finns ett värde i x-cellen ovanför den markerade x-cellen trycker du
på  eller  för att automatiskt mata in värdet i den markerade cellen
som är lika med värdet för cellen ovanför den plus stegvärdet. Genom
att trycka på  kan du även automatiskt mata in värdet lika med värdet
för cellen ovanför minus stegvärdet. f(x)- och g(x)-värdena på samma rad
uppdateras också i enlighet med detta.

Bestämma tid för uppdatering av f(x) och g(x)
f(x)- och g(x)-värdena som visas på nummertabellskärmen uppdateras när
något av följande inträffar.
• Om  trycks in medan [Execute] är markerat på Table Range-skärmen.
• När de definierande ekvationerna för f(x) och g(x) uppdateras (utom när

en definierande ekvation är en sammansatt funktion).
• När ett tal matas in i kolumn x (inklusive tryckning på , ,  i

kolumn x).

Observera dock att värdena inte uppdateras automatiskt efter följande
åtgärder.
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• När SETTINGS-menyn används för att ändra Angle Unit-inställningen.
• När variabeln i en definierande ekvation uppdateras (nytt numeriskt

värde lagras) när en definierande ekvation som innehåller en variabel
(till exempel: f(x) = 2x + A) registreras.

• När en definierade ekvation för en sammansatt funktion (till exempel:
g(x) = f(x) × 2 - x) registreras och den definierande ekvationen för
referensfunktionen (till exempel: f(x) för g(x) = f(x) × 2 - x) uppdateras
(ny registrerad definierande ekvation).

I dessa fall ska du köra  – [Recalculate] samtidigt som
nummertabellskärmen visas för att uppdatera värden.

Datalagring
Om du gör följande kommer vissa data att tas bort och vissa inställningar i
Table-läget rensas.① Gå tillbaka till HOME-skärmen och starta ett annat räknarläge.② Tryck på .③ Ändra Input/Output-inställningen med SETTINGS-menyn.④ Ändra Table Type-inställningen med TOOLS-menyn.
Tabellen nedan visar vilka data som kasseras och vilka data som lagras.

Operation ① ② ③ ④
Nummertabelldata
(x-, f(x)-, g(x)-kolumner) Kasserad Kasserad Kasserad Kasserad

Table Range-
inställningar Kasserad Behålls Behålls Behålls

Table Type-inställningar Behålls Behålls Behålls --
f(x), g(x) definierar
ekvationer Behålls Kasserad Kasserad Behålls

Ekvationsberäkningar
Equation-läget har de tre funktionerna som beskrivs nedan. När du har
startat läget kan du använda Equation-menyn som visas för att välja den
funktion du vill.

Simul Equation: Simultana linjära ekvationer med två till fyra okända
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Polynomial: Höggradsekvationer från 2:a till 4:e graden
Solver: Funktion för att hitta värdet på en variabel som finns i en inmatad
ekvation

Simultana linjära ekvationer
Här förklarar vi den allmänna proceduren för att lösa en simultan ekvation
med ett exempel där vi tar upp en simultan linjär ekvation med tre okända.

Exempel 1: 

1. Tryck på , välj ikonen för Equation-läget och tryck sedan på .
• Då visas Equation-menyn.

2. Välj [Simul Equation] och tryck sedan på .
• Då visas menyn för okända.

3. Välj [3 Unknowns] och tryck sedan på .
• Då visas koefficientredigeraren.

4. Använd koefficientredigeraren för att ange koefficientvärdena.

1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• Om du trycker på  när koefficientredigeraren visas så rensas alla
koefficienter och nollställs.

5. Tryck på .
• Då visas en lösning.
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• När indikatorn  visas så kan du visa en ny lösning för varje tryck på
 (eller ).

 (eller )

 (eller )

• Om du trycker på  eller  medan indikatorn  visas så dyker den
lösning som visades tidigare upp igen.

• Om du trycker på  medan den slutliga lösningen visas återgår du till
koefficientredigeraren. Om du vill gå tillbaka till koefficientredigeraren
medan lösningen visas trycker du på .

• Om du trycker på  när koefficientredigeraren visas återgår du till
menyn för antal okända.

Obs!

• När koefficientredigeraren visas kan du lagra det aktuella markerade värdet till en
variabel. När lösningen visas går det också bra att lagra aktuellt visad lösning till en
variabel. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x, y, z)”
(sida 35).

Höggradsekvationer från 2:a till 4:e graden
När du löser en höggradsevkation med Equation-läget så visas värdena
nedan enligt ekvationens grad.

• Kvadratisk ekvation
Efter att lösningen för ax2+bx+c=0 har visats så visas de minsta (eller
högsta) koordinaterna (x, y) för y=ax2+bx+c.

• Kubisk ekvation
Efter visning av lösningen på ax3+bx2+cx+d=0 så visas koordinaterna (x,
y) för lokala minsta (eller lokala högsta) värde y=ax3+bx2+cx+d, endast
om det finns ett lokalt minsta eller högsta värde. Om det inte finns ett
lokalt minsta eller lokalt högsta värde så visas meddelandet No Local
Max/Min om du trycker på .

• Kvadratisk ekvation
Lösningen för ax4+bx3+cx2+dx+e=0 visas.

Här visar vi ett exempel på en kvadratisk ekvation för att förklara den
allmänna proceduren för att lösa en höggradsekvation.
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Exempel 2: x2 + 2x − 2 = 0
(Input/Output: MathI/MathO)
1. Tryck på , välj ikonen för Equation-läget och tryck sedan på .

• Då visas Equation-menyn.

2. Välj [Polynomial] och tryck sedan på .
• Då visas menyn för grader.

3. Välj [ax2+bx+c] och tryck sedan på .
• Då visas koefficientredigeraren.

4. Använd koefficientredigeraren för att ange koefficientvärdena.

1 2 ((-))2

• Om du trycker på  när koefficientredigeraren visas så rensas alla
koefficienter och nollställs.

5. Tryck på .
• Då visas en lösning.

• När indikatorn  visas så kan du visa ett nytt beräkningsresultat
(lösning eller koordinat) för varje tryck på  (eller ).

 (eller )

(Visar x-koordinat för minsta värdet för y = x2 + 2x − 2.)
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 (eller )

(Visar y-koordinat för minsta värde för y = x2 + 2x − 2.)

 (eller )

• Om du trycker på  eller  medan indikatorn  visas så visas den
beräkning som visades tidigare igen.

• Om du trycker på  medan det slutliga beräkningsresultatet visas
återgår du till koefficientredigeraren. Om du vill gå tillbaka till
koefficientredigeraren medan beräkningsresultatet visas trycker du på

.
• Om du trycker på  medan koefficientredigeraren visas återgår du till

menyn för antal grader.

Obs!

• När koefficientredigeraren visas kan du lagra det aktuella markerade värdet till en
variabel. Även om ett beräkningsresultat (lösning eller koordinat) visas kan det lagras i
en variabel. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x, y,
z)” (sida 35).

Visning av komplexa tallösningar (Complex Roots)

Höggradsekvationer kan ha komplexa tallösningar. Om du väljer
Polynomial i Equation-menyn kan du använda åtgärderna nedan för att
aktivera eller avaktivera visning av komplexa tallösningar.

 – [Complex Roots] > [On] 
Aktiverar visning av komplexa tallösningar (initial standardinställning).

 – [Complex Roots] > [Off] 
Avaktiverar visning av komplexa tallösningar. Om du lägger in och kör
en ekvation som har en eller flera tallösningar så visas meddelandet
No Real Roots.

Exempel 3: 2x2 + 3x + 4 = 0
(Input/Output: MathI/MathO, Complex Result: a+bi, Complex Roots: On)
1. Tryck på , välj ikonen för Equation-läget och tryck sedan på .

• Då visas Equation-menyn.
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2. Välj [Polynomial] > [ax2+bx+c].
• Då visas koefficientredigeraren.

3. Använd koefficientredigeraren för att ange koefficientvärdena.

2 3 4

4. Tryck på .
• Då visas en lösning.

5. Visa en annan lösning och koordinatvärden.

 (eller )

 (eller )

 (eller )

• Om du trycker på  medan det slutliga beräkningsresultatet visas
återgår du till koefficientredigeraren. Om du vill gå tillbaka till
koefficientredigeraren medan beräkningsresultatet visas trycker du på

.
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Konvertera en komplex tallösning till rektangulära eller polära
koordinater

Du kan använda FORMAT-menyn som visas när du trycker på  för att
konvertera en komplex nummerlösning till en rektangulär koordinat eller
polär koordinat.

Exempel 4: För att konvertera den komplexa tallösningen som visas i
Exempel 3 (sida 102) till polärt koordinatformat och sedan till rektangulärt
koordinatformat
1. Utför steg 1 till 4 i Exempel 3 (sida 102).

2. Tryck på , välj [Polar Coord] och tryck sedan på .
• Då konverteras lösningen till polärt koordinatformat.

3. Tryck på , välj [Rectangular Coord] och tryck sedan på .
• Då konverteras lösningen till rektangulärt koordinatformat.

Använda Solver
Solver använder Newtons metod för att approximera lösningen av
ekvationer. Solver har stöd för inmatning av ekvationer i följande format.
Exempel: y = x + 5, x = sin(A), xy + C (Behandlas som xy + C = 0)

Exempel 5: För att lösa x2 - B
2  = 0 for x när B = 4

(Input/Output: MathI/MathO)

Obs!

• Innan du löser x2 - B
2  = 0 for x måste 4 lagras i variabel B. Detta görs i steg 3 i

proceduren nedan.

1. Tryck på , välj ikonen för Equation-läget och tryck sedan på .
• Då visas Equation-menyn.

2. Välj [Solver] och tryck sedan på .
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• Då visas Solver-skärmen för ekvationsinmatning.
3. Här lagrar du 4 till variabel B.

4

• Den här åtgärden kan utföras när som helst före steg 7 i den här
proceduren.

• Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x,
y, z)” (sida 35).

• Tryck på  för att återgå till Solver-skärmen för ekvationsinmatning.
4. Mata in ekvationen.

(B) 2
(=)*0

* Du kan också använda följande åtgärd för att mata in tecknet =.  –
[Equation] > [=].

5. Tryck på  för att registrera den inmatade ekvationen.
6. På Solve Target-skärmen som visas bekräftar du att [x] har valts och

trycker sedan på .
• Då visas en skärm med det ursprungliga värdet x.

7. Mata in 1 som startvärde på x.

1

8. När du har kontrollerat att [Execute] har valts trycker du på  för att
lösa ekvationen.

(1) Variabel löst för
(2) Lösning
(3) Resultat på (vänster sida) – (höger sida)

• Lösningar visas alltid i decimalform.
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• Ju närmare resultatet (vänster sida) − (höger sida) är noll desto högre
noggrannhet har lösningen.

9. Tryck sedan på den knapp som utför den åtgärd du vill använda.

Så här gör du:
Tryck på den här
tangenten:

Gå tillbaka till skärmen i steg 6. *

Lagra inmatningsuttrycket och återgå till
skärmen i steg 4.

 eller 

* Startvärde när du trycker på den här tangenten blir det initiala värde
som du senast använde för beräkningen.

Viktigt!

• Solver utför konvergens ett förinställt antal gånger. Om
du inte kan hitta en lösning visas en bekräftelseskärm
som den i närheten och du får frågan om du vill
fortsätta. Tryck på  medan [Continue] är valt för att
fortsätta eller välj [Exit] och sedan  för att avbryta
Solver-åtgärden.

• Beroende på vad du anger för det initiala värdet för lösningsvariabeln (x i exemplet
ovan) kan det hända att Solver inte kan erhålla en lösning. Om detta händer kan du
försöka ändra det ursprungliga värdet så att det ligger närmare lösningen.

• Solver kanske inte kan avgöra vilken lösning som är rätt, även om den finns.
• Solver använder Newtons metod, så även om det finns flera lösningar kommer endast

en av dem att returneras.
• På grund av begränsningar i Newtons metod tenderar lösningar att vara svåra att

erhålla för följande ekvationer: y=sinx, y=ex, y=√x.

Ojämlikhetsberäkningar
Du kan använda Inequality-läget för att lösa ojämlikhter av 2:a, 3:e och 4:e
graden.

Allmän procedur för att utföra en
ojämlikhetsberäkning

Exempel 1: För att lösa x2 + 2x - 3 ≥ 0
1. Tryck på , välj ikonen för Inequality-läget och tryck sedan på .

• Då visas menyn för grader.
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2. Välj [ax2+bx+c] och tryck sedan på .

3. På menyn som visas väljer du ojämlikhetssymbolens typ och inriktning
(>, <, ≥, ≤).
• Här vill vi lösa x2 + 2x - 3 ≥ 0, välj [ax2+bx+c≥0] och tryck sedan på .

4. I koefficientredigeraren som visas anger du koefficientvärdena.

1 2 ((-))3

5. Tryck på .
• Då visas lösningen.

• Om du vill gå tillbaka till koefficientredigeraren medan lösningen visas
trycker du på ,  eller .

• Om du trycker på  medan koefficientredigeraren visas återgår du till
menyn i steg 2.

• Om du trycker på  medan menyn i steg 2 visas återgår du till
menyn för grader.

Obs!

• Lösningarna visas så som de visas på skärmen nedan när någonting annat än MathI/
MathO väljs för inställningen Input/Output i SETTINGS-menyn.

• No Solution visas på lösningsskärmen när det inte finns någon lösning för en
ojämlikhet (t.ex. x2 < 0).

• All Real Numbers visas på lösningsskärmen när lösningen av en ojämlikhet är alla
nummer (t.ex. x2 ≥ 0).
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Komplexa talberäkningar
Om du vill utföra komplicerade talberäkningar startar du först Complex-
läget.
Tryck på , välj ikonen för Complex-läget och tryck sedan på .

Mata in komplexa tal
Du kan använda antingen rektangulära koordinater (a+bi) eller polära
koordinater (r∠θ) för att mata in komplexa tal.

Exempel 1: Mata in 2+3i

2 3 (i)*

* Du kan också använda följande åtgärd för att mata in i:  – [Complex] >
[i].

Exempel 2: Mata in 5∠30

5  – [Complex] > [∠] 30

Beräkningsexempel för Complex-läget

Innan du utför exempeloperationerna

• För exemplen i det här avsnittet använder du SETTINGS-menyn för
att välja MathI/MathO för Input/Output-inställningen. Konfigurera andra
inställningar så som visas för varje exempel.

• Beräkningsresultat för komplexa tal visas i enlighet med Complex
Result-inställningen på SETTINGS-menyn.

• Om du planerar att mata in och visa beräkningsresultatet i polärt
koordinatformat anger du Angle Unit i SETTINGS-menyn innan du
påbörjar beräkningen.

• θ-värdet för beräkningsresultatet visas i intervallet -180° < θ ≤ 180°.
• Om beräkningsresultat visas medan något annat än MathI/MathO är valt

visar a och bi (eller r och θ) på separata rader.

Exempel 3: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)

108



Obs!

• När ett komplext tal höjs till ett heltal med hjälp av syntaxen (a+bi)n, så kan
effektvärdet ligga inom följande intervall: -1 × 1010 < n < 1 × 1010.

Exempel 4: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2  – [Complex] > [∠] 45

Exempel 5: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

Exempel 6: För att erhålla det komplexa konjugatet 2 + 3i
(Complex Result: a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

Exempel 7: För att erhålla det absoluta värdet och argumentet för 1 + i
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

Exempel 8: För att extrahera den verkliga delen och imaginära delen av 2
+ 3i

 – [Complex] > [Real Part]
2 3 (i)
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 – [Complex] > [Imaginary Part]
2 3 (i)

Konvertera ett resultat för en komplex talberäkning till
rektangulära eller polära koordinater

Du kan använda FORMAT-menyn som visas när du trycker på  för att
konvertera resultatet för en komplex beräkning till en rektangulär koordinat
eller polär koordinat.

Exempel 9: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

Bas-n-beräkningar
Om du vill utföra decimala, hexadecimala, binära eller oktala beräkningar
ska du använda Base-N-läget. Tryck på , välj ikonen för Base-N-läget
och tryck sedan på . Standardinställt nummerläge för Base-N-läget är
decimalvärden.

När du har öppnat Base-N-läget trycker du på  för att växla mellan olika
nummerlägen.
Vid varje tryck på  bläddrat du ett steg till genom följande nummerlägen.

(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]
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Obs!

• De värden i nedsänkt läge som visas i exemplen indikerar basen (nummerläge) för
varje värde.
Exempel: 12 ... Binär 1; 116 ... Hexadecimal 1

Exempel 1: För att beräkna 112 + 12

1. Använd  för att ändra nummerläget till [Binary].
2. Utför beräkningen 112 + 12.

11 1

Exempel 2: För att beräkna 1F16 + 116 i hexadecimal
1. Använd  för att ändra nummerläget till [Hexadecimal].
2. Utför beräkningen 1F16 + 116.

1 (F) 1

Obs!

• Använd följande tangenter för att mata in bokstäverna A till F för hexadecimala
värden: (A), (B), (C), (D), (E), (F). Du kan
även mata in hexadecimala värden med alternativen i CATALOG-menyn nedan.

 – [Hex Value] > [A], [B], [C], [D], [E] eller [F]
• Observera att om du anger ett tecken från A till F med hjälp av åtgärden nedan

kommer tecknet att behandlas som ett variabelnamn och inte som ett hexadecimalt
värde.
(1) Tryck på  för att visa skärmen med variabellistan.
(2) Välj [A=], [B=], [C=], [D=], [E=] eller [F=] och tryck sedan på .
(3) På menyn som visas väljer du [Recall].

• I Base-N-läget stöds inte inmatning av decimalvärden och exponenter. Om ett
beräkningsresultat har en bråkdel tas den bort.

• Information om in- och utmatningsintervall (32 bitar) visas nedan.•

Bas Intervall

Binär

Positiv: 00000000000000000000000000000000 ≤ x ≤
01111111111111111111111111111111
Negativ: 10000000000000000000000000000000 ≤ x ≤
11111111111111111111111111111111

Oktal
Positiv: 00000000000 ≤ x ≤ 17777777777
Negativ: 20000000000 ≤ x ≤ 37777777777
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Decimal -2147483648 ≤ x ≤ 2147483647

Hexadecimal
Positiv: 00000000 ≤ x ≤ 7FFFFFFF
Negativ: 80000000 ≤ x ≤ FFFFFFFF

• Ett Math ERROR inträffar när ett beräkningsresultat ligger utanför det tillämpliga
intervallet för det nummersystem som används.

Ange sifferläge för ett visst inmatat värde
Du kan ange ett särskilt kommando omedelbart före ett värde för att
ange nummerläget för det värdet. Specialkommandon är: d (decimal), h
(hexadecimal), b (binär) och o (oktal).

Exempel 3: För att beräkna 1010 + 1016 + 102 + 108 och visa resultatet
som ett decimalvärde
1. Använd  för att ändra nummerläget till [Decimal].
2. Utför beräkningen 1010 + 1016 + 102 + 108.

 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

 – [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

Konvertera ett beräkningsresultat till en annan typ
av värde

Du kan använda  för att konvertera det beräkningsresultat som visas till
en annan typ av värde.

Exempel 4: För att beräkna 1510 × 3710 i decimalläget och sedan
konvertera resultatet till hexadecimalt
1. Använd  för att ändra nummerläget till [Decimal].
2. Utför beräkningen 1510 × 3710.

15 37

3. Använd  för att ändra nummerläget till [Hexadecimal].
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Logiska och negativa operationer
Logiska och negativa operationer utförs genom att trycka på  och välja
[Logic Operation] och sedan välja önskat kommando (Neg, Not, and, or,
xor, xnor) i menyn som visas. Alla exempel nedan utförs i binärt läge.

Exempel 5: För att bestämma logiskt AND för 10102 och 11002 (10102

and 11002)

1010
 – [Logic Operation] > [and]

1100

Exempel 6: För att bestämma det bitvisa komplementet till 10102

(Not(10102))

 – [Logic Operation] > [Not]
1010

Obs!

• För negativa binära, oktala och hexadecimala värden konverterar räknaren värdet
till binärt, tar tvåans komplement och konverterar sedan tillbaka till den ursprungliga
nummerbasen. För decimalvärden lägger räknaren bara till ett minustecken.

Matrisberäkningar
Använd Matrix-läget för att utföra beräkningar som omfattar matriser med
upp till 4 rader och 4 kolumner.

Allmän procedur för att utföra en matrisberäkning
För att utföra matrisberäkningar ska speciella matrisvariabler (MatA, MatB,
MatC, MatD), användas så som visas i nedanstående exempel.

Exempel 1: För att beräkna 

• För multiplikation (matris 1 × matris 2) måste antalet kolumner i matris 1
matcha antalet rader i matris 2. Annars uppstår ett fel.

1. Tryck på , välj ikonen för Matrix-läget och tryck sedan på .
• Då visas skärmen för matrisberäkning.
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2. Tryck på .
• Då visas skärmen för matrisvariabellista.

• Mer information om skärmen för matrisvariabellista, och hur du utför
lagring, redigering eller andra åtgärder för matrisvariabler, hittar du
under ”Skärmen för matrisvariabellista” (sida 115).

3. Utför stegen nedan för att lagra till MatA.

(1) Välj [MatA:] och tryck sedan på .
• Då visas skärmen för inställning av matrisstorlek (ursprunglig

standardinställning: 2 rader, 2 kolumner).

(2) Här vill vi lagra en 2x2-matris, välj därför [Confirm] och tryck sedan
på .
• Då visas matrisredigeraren för inmatning av elementen i 2x2-

matrisen för MatA.

(3) Mata in elementen i MatA.

2 1 1 1

(4) Tryck på ,  eller  för att gå tillbaka till skärmen för
matrisberäkningar.

4. Utför stegen nedan för att lagra till MatB.

(1) Tryck på , välj [MatB:] och tryck sedan på .
(2) Välj [Confirm] och tryck sedan på .
(3) Mata in elementen i MatB.
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2 ((-))1 ((-))1 2

(4) Tryck på ,  eller  för att gå tillbaka till skärmen för
matrisberäkningar.

5. Mata in MatA×MatB.

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6. Tryck på .
• Detta visar MatAns-skärmen (Matrix Answer Memory) med

beräkningsresultatet.

• Mer information om MatAns finns i ”Matrissvarminne (MatAns)”
(sida 118).

• Om du trycker på  medan MatAns-skärmen visas återgår du till
skärmen för vektorberäkning och raderar beräkningsuttrycket. Om du
trycker på  eller  återgår du till läget för slutförande av inmatning
av beräkningsuttryck i steg 5 för den här proceduren.

Obs!

• När matrisredigeraren eller MatAns-skärmen visas kan du lagra det aktuella
markerade värdet till en variabel. Medan skärmen för matrisberäkningar visas och
ett beräkningsresultat finns på skärmen kan du lagra det visade beräkningsresultatet
till en variabel. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x,
y, z)” (sida 35).

Skärmen för matrisvariabellista
Skärmen för matrisvariabellista är den ingångsportal du ska använda när
du vill lagra en matris i matrisvariabeln MatA, MatB, MatC eller MatD, eller
om du vill redigera en tidigare lagrad vektor. Status för varje matrisvariabel
anges enligt exemplen nedan.
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(1) 2×2
Indikerar att en 2x2-matris lagras i matrisvariabeln.

(2) None
Indikerar att ingenting lagras i matrisvariabeln.

Visa skärmen för matrisvariabellistan

Utför någon av åtgärderna nedan, beroende på vilken skärm som visas.
• När skärmen för matrisberäkning visas:

Tryck på .
• När skärmen för matrisredigering eller MatAns visas:

Tryck på , välj [Define Matrix] och tryck sedan på .

Lagra nya data i en matrisvariabel

Exempel 2: För att lagra 2×3-matrisen 

1. När skärmen för matrisberäkning visas trycker du på  för att visa
skärmen för matrisvariabellista.

2. Välj den matrisvariabel (MatA, MatB, MatC eller MatD) som du vill lagra
nya data till och tryck sedan på .
• Om du valde en matrisvariabel vars status är None går du vidare till

steg 4 i den här proceduren.
• Om du valde en matrisvariabel som redan har en matris lagrad på den

visas en menyskärm. Gå vidare till steg 3.

3. Välj [Define New] och tryck sedan på .
4. På Matrix Size?-skärmen som visas anger du antal rader och kolumner i

matrisen.

• Om du specificera 2x3-matriser utför du stegen nedan.
(1) Välj [Rows] och tryck sedan på . I menyn som visas väljer du [2

Rows] och trycker sedan på .
(2) Välj [Columns] och tryck sedan på . I menyn som visas väljer du

[3 Columns] och trycker sedan på .
5. När rad- och kolumnspecifikationerna är som du vill ha den väljer du

[Confirm] och trycker sedan på .
• Då visas matrisredigeraren.
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6. Mata in elementen i matrisvariabeln.

1 0 ((-))1
0 ((-))1 1

7. Tryck på ,  eller  för att gå tillbaka till skärmen för
matrisberäkningar.

Obs!

• Matrisvariabelinnehåll behålls även om du trycker på , ändrar räknarens läge eller
stänger av räknaren. Om du utför någon av åtgärderna nedan rensas innehållet i alla
matrisvariabler.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Redigera matrisvariabeldata

1. När skärmen för matrisberäkning visas trycker du på  för att visa
skärmen för matrisvariabellista.

2. Välj den matrisvariabel (MatA, MatB, MatC, eller MatD) som du vill
redigera och tryck sedan på .

3. I menyn som visas väljer du [Edit] och trycker sedan på .
• Då visas matrisredigeraren.

4. Använd matrisredigeraren för att redigera vektorns element.
• Flytta markören till cellen som innehåller det element du vill redigera,

ange det nya värdet och tryck sedan på .
5. Tryck på ,  eller  för att gå tillbaka till skärmen för

matrisberäkningar.

Kopiera innehåll i matrisvariabel (eller MatAns)

1. Visa matrisredigerar- eller MatAns-skärmen för den vektorvariabel som
du vill använda som kopieringskälla.
• För att visa matrisredigeraren utför du steg 1, 2 och 3 under

”Redigera matrisvariabeldata” (sida 117).
• Om du vill visa MatAns-skärmen utför du stegen nedan medan

matrisberäkningsskärmen visas.
 – [Matrix] > [MatAns] 

2. Välj destination för matrisvariabelkopiering.
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• Till exempel, om du vill kopiera till MatD utför du följande åtgärder: 
– [Store] > [MatD].

• Detta visar matrisredigeraren med innehållet i
kopieringsdestinationen.

3. Tryck på ,  eller  för att gå tillbaka till skärmen för
matrisberäkningar.

Matrissvarminne (MatAns)
När resultatet av en beräkning som utförs i Matrix-läget är en vektor visas
MatAns-skärmen med resultatet. Resultatet kommer också att lagras i en
variabel som kallas MatAns.

MatsAns-variabeln kan användas i beräkningar enligt beskrivningen
nedan.
• Så här infogar du MatAns-variabeln i en beräkning:  – [Matrix] >

[MatAns].
• Om du trycker på någon av följande knappar medan MatAns-skärmen

visas växlar den automatiskt till vektorberäkningsskärmen, med VctAns
följt av operatören eller funktionen för den tangent du tryckte på: , ,

, , , , , ( ), ( ).

Obs!

• MatAns-innehåll behålls även om du trycker på  eller stänger av räknaren. Om du
utför någon av åtgärderna nedan rensas innehållet i MatAns.
- Gå tillbaka till HOME-skärmen och starta ett annat räknarläge
- Utför  – [Reset] > [Settings & Data]
- Utför  – [Reset] > [Initialize All]

Matrisberäkningsexempel

I exemplen nedan används MatA = , MatB = , MatC =

, MatD = .

Exempel 3: För att lägga till två matriser (MatA + MatB)

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 
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Obs!

• De två matriserna måste ha samma dimensioner för att kunna läggas till eller
subtraheras. Ett fel uppstår om du försöker lägga till eller subtrahera matriser med
olika dimensioner.

Exempel 4: För att använda kvadratisk och kubisk MatA (MatA2, MatA3)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]

Exempel 5: För att invertera MatA (MatA-1)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

Obs!

• Endast kvadratiska matriser (samma antal rader och kolumner) kan inverteras. Om du
försöker invertera en matris som inte är kvadratisk uppstår ett fel.

• En matris med en determinant på noll kan inte inverteras. Om du försöker invertera en
matris med en determinant på noll uppstår ett fel.

• Beräkningsprecisionen påverkas för matriser vars determinant är nära noll.

Exempel 6: För att erhålla bestämningsfaktorn för MatA (Det(MatA))
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 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]

Obs!

• Determinanter kan endast erhållas för kvadratiska matriser (samma antal rader och
kolumner). Om du försöker erhålla en determinant för en matris som inte är kvadratisk
uppstår ett fel.

Exempel 7: För att erhålla transposition för MatC (Trn(MatC))

 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

Exempel 8: För att skapa en 2 x 2-identitetsmatris och lägga till den i
MatA (Identity(2) + MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

Obs!

• Du kan ange ett värde från 1 till 4 som kommandoradsargumentet för Identity (antal
dimensioner).

Exempel 9: För att erhålla det absoluta värdet för varje element för MatC
(Abs(MatC))

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]
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Vektorberäkningar
Använd Vector-läget för att utföra 2-dimensionella och 3-dimensionella
vektorberäkningar.

Allmän procedur för att utföra en vektorberäkning
För att utföra vektorberäkningar ska speciella vektorvariabler användas
(VctA, VctB, VctC, VctD), så som visas i nedanstående exempel.

Exempel 1: För att beräkna (1, 2 )+ (3, 4)
• När du utför addition eller subtraktion av två vektorer måste båda ha

samma dimensioner.
1. Tryck på , välj ikonen för Vector-läget och tryck sedan på .

• Då visas skärmen för vektorberäkning.

2. Tryck på .
• Då visas skärmen för vektorvariabellista.

• Mer information om skärmen för vektorvariabellista, och hur du utför
lagring, redigering eller andra åtgärder för vektorvariabler, hittar du
under ”Skärmen för vektorvariabellista” (sida 123).

3. Utför stegen nedan för att lagra (1, 2) till VctA.
(1) Välj [VctA:] och tryck sedan på .

• Då visas skärmen för inställning av vektormått (ursprunglig
standardinställning: 2 dimensioner).

(2) Här vill vi lagra en tvådimensionell vektor, välj därför [Confirm] och
tryck sedan på .

• Detta visar vektorredigeraren för inmatning av den
tvådimensionella vektorn för VctA.
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(3) Mata in elementen i VctA.

1 2

(4) Tryck på ,  eller  för att gå tillbaka till skärmen för
vektorberäkningar.

4. Utför stegen nedan för att lagra (3, 4) till VctB.
(1) Tryck på , välj [VctB:] och tryck sedan på .
(2) Välj [Confirm] och tryck sedan på .
(3) Mata in elementen i VctB.

3 4

(4) Tryck på ,  eller  för att gå tillbaka till skärmen för
vektorberäkningar.

5. Mata in VctA+VctB.

 – [Vector] > [VctA]
 – [Vector] > [VctB]

6. Tryck på .
• Detta visar VctAns-skärmen (Vector Answer Memory) med

beräkningsresultatet.

• Mer information om VctAns finns i ”Vektorsvarsminne (VctAns)”
(sida 125).

• Om du trycker på  medan VctAns-skärmen visas återgår du till
skärmen för vektorberäkning och raderar beräkningsuttrycket. Om du
trycker på  eller  återgår du till läget för slutförande av inmatning
av beräkningsuttryck i steg 5 för den här proceduren.
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Obs!

• När vektorredigeraren eller VctAns-skärmen visas kan du lagra det aktuella
markerade värdet till en variabel. Medan skärmen för vektorberäkning visas och ett
beräkningsresultat finns på skärmen kan du lagra det visade beräkningsresultatet till
en variabel. Mer information om variabler hittar du i ”Variabler (A, B, C, D, E, F, x, y,
z)” (sida 35).

Skärmen för vektorvariabellista
Skärmen för vektorvariabellista är den ingångsportal du ska använda när
du vill lagra en vektor i vektorvariabeln VctA, VctB, VctC eller VctD, eller
för att redigera en tidigare lagrad vektor. Status för varje vektorvariabel
anges enligt exemplen nedan.

(1) 2
Indikerar att en tvådimensionell vektor lagras i vektorvariabeln.

(2) None
Indikerar att ingenting lagras i vektorvariabeln.

Visa skärmen för vektorvariabellistan

Utför någon av åtgärderna nedan, beroende på vilken skärm som visas.
• När skärmen för vektorberäkning visas:

Tryck på .
• När skärmen för vektorredigering eller VctAns visas:

Tryck på , välj [Define Vector] och tryck sedan på .

Lagra nya data i en vektorvariabel

Exempel 2: Lagra den tredimensionella vektorn (1, 2, 3)
1. När skärmen för vektorberäkning visas trycker du på  för att visa

skärmen för vektorvariabellista.
2. Välj den vektorvariabel (VctA, VctB, VctC eller VctD) som du vill lagra

nya data till och tryck sedan på .
• Om du valde en vektorvariabel vars status är None går du vidare till

steg 4 i den här proceduren.
• Om du valde en vektorvariabel som redan har en vektor lagrad på den

visas en menyskärm. Gå vidare till steg 3.
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3. Välj [Define New] och tryck sedan på .
4. På Vector Dimension?-skärmen som visas anger du vektordimensionen.

• Om du vill ange tre dimensioner utför du stegen nedan.
(1) Välj [Dimensions] och tryck sedan på .
(2) I menyn som visas väljer du [3 Dimensions] och trycker sedan på .

5. När dimensonspecifikation är som du vill ha den väljer du [Confirm] och
trycker sedan på .
• Detta visar vektorredigeraren.

6. Mata in elementen i vektorvariabeln.

1 2 3

7. Tryck på ,  eller  för att återgå till vektorberäkningsskärmen.

Obs!

• Vektorvariabelinnehåll behålls även om du trycker på , ändrar räknarens läge eller
stänger av räknaren. Om du utför någon av åtgärderna nedan rensas innehållet i alla
vektorvariabler.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Redigera vektorvariabeldata

1. När skärmen för vektorberäkning visas trycker du på  för att visa
skärmen för vektorvariabellista.

2. Välj den vektorvariabel (VctA, VctB, VctC eller VctD) som du vill
redigera och tryck sedan på .

3. I menyn som visas väljer du [Edit] och trycker sedan på .
• Detta visar vektorredigeraren.
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4. Använd vektorredigeraren för att redigera vektorns element.
• Flytta markören till cellen som innehåller det element du vill redigera,

ange det nya värdet och tryck sedan på .
5. Tryck på ,  eller  för att återgå till vektorberäkningsskärmen.

Kopiera innehållet i vektorvariabel (eller VctAns)

1. Visa vektorredigerar- eller VctAns-skärmen för den vektorvariabel som
du vill använda som kopieringskälla.
• För att visa vektorredigeraren utför du steg 1, 2 och 3 under

”Redigera vektorvariabeldata” (sida 124).
• Om du vill visa VctAns-skärmen utför du stegen nedan medan

vektorberäkningsskärmen visas.
 – [Vector] > [VctAns] 

2. Välj destination för vektorvariabelkopiering.
• Till exempel, om du vill kopiera till VctD utför du följande åtgärder: 

– [Store] > [VctD].
• Detta visar vektorredigeraren med innehållet i

kopieringsdestinationen.
3. Tryck på ,  eller  för att återgå till vektorberäkningsskärmen.

Vektorsvarsminne (VctAns)
När resultatet av en beräkning som utförs i Vector-läget är en vektor visas
VctAns-skärmen med resultatet. Resultatet kommer också att lagras i en
variabel som kallas VctAns.

Variabeln kan användas i beräkningar enligt beskrivningen nedan.
• Så här infogar du VctAns-variabeln i en beräkning:  – [Vector] >

[VctAns].
• Om du trycker på någon av följande knappar medan VctAns-skärmen

visas växlar den automatiskt till vektorberäkningsskärmen, med VctAns
följt av operatören eller funktionen för den tangent du tryckte på: , ,

, , , , , ( ), ( ).

Obs!

• VctAns-innehåll behålls även om du trycker på  eller stänger av räknaren. Om du
utför någon av åtgärderna nedan rensas innehållet i VctAns.
- Gå tillbaka till HOME-skärmen och starta ett annat räknarläge
- Utför  – [Reset] > [Settings & Data]
- Utför  – [Reset] > [Initialize All]
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Vektorberäkningsexempel
Exemplen nedan använder VctA = (1, 2) och VctB = (3, 4) och VctC = (2,
-1, 2).

Exempel 3: VctA • VctB (punktprodukt av vektorer)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

Obs!

• Vid beräkning av en punktprodukt måste måtten för de två vektorerna vara desamma.

Exempel 4: VctA× VctB (kryssprodukt av vektorer)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

Obs!

• Vid beräkning av en kryssprodukt måste måtten för de två vektorerna vara desamma.

Exempel 5: För att bestämma vinkeln som bildas av VctA och VctB till tre
decimaler. (Number Format: Fix 3, Angle Unit: Degree)

 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

Obs!

• Vid beräkning av en vinkel som bildas av två vektorer måste måtten för de två
vektorerna vara desamma.

Exempel 6: För att normalisera VctB
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 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]

Exempel 7: För att erhålla absoluta värden för VctC

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]

Kvotberäkningar
Med Ratio-läget kan du bestämma värdet på X i kvotuttrycket A : B = X : D
(eller A : B = C : X) när värdena för A, B, C och D är kända.

Allmän procedur för att utföra en kvotberäkning
Exempel 1: Så här löser du 3 : 8 = X : 12 för X
1. Tryck på , välj ikonen för Ratio-läget och tryck sedan på .
2. I menyn som visas väljer du [A:B=X:D] eller [A:B=C:X].

• Här vill vi lösa 3 : 8 = X : 12 för X, välj [A:B=X:D] och tryck sedan på
.

3. I koefficientredigeraren som visas anger du koefficientvärdena.
• Här anger vi följande för koefficienterna: A = 3, B = 8, D = 12.

3 8 12

4. När alla värden är som du vill ha trycker du på .
• Då visas lösningen (värdet X).

• Tryck på ,  eller  för att återgå till koefficientredigeraren.

Obs!

• Ett Math ERROR inträffar om du utför en beräkning medan 0 är indata för en
koefficient.

• Om du utför stegen nedan återställs alla koefficienter i koefficientredigaren till 1.
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– När du är i koefficientredigeraren trycker du på , ,  eller .
– När en lösning visas trycker du på  eller .

• Du kan lagra det beräkningsresultat som visas för tillfället i en variabel. Om du
till exempel utför följande åtgärd medan skärmen i steg 4 visas ovan sparas
beräkningsresultatet till variabel A:  – [A=] > [Store]. Mer information om variabler
hittar du i ”Variabler (A, B, C, D, E, F, x, y, z)” (sida 35).

För att ändra kvotuttryckstypen

1. När koefficientredigeraren visas trycker du på .
2. På menyn som visas väljer du önskad typ av uttryck.

Beräkningsexempel
Exempel 2: Så här beräknar du X i kvoten 1 : 2 = X : 10

 – [Ratio] > [A:B=X:D]
1 2 10

Använda Math Box
Math Box-läget har följande funktioner för utbildningssupport.
Dice Roll: Dice Roll är en funktion som simulerar tärningskastning.
Coin Toss: Coin Toss är en funktion som simulerar myntkastning.

Dice Roll
Dice Roll simulerar en, två eller tre virtuella tärningar som kastas ett
angivet antal gånger. Du kan välja någon av följande skärmar för
resultatet.

List-skärmen
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Relative Freq-skärmen

Allmän procedur för Dice Roll

Exempel: För att simulera 100 kast med två tärningar. I det här
exemplet används Relative Freq-skärmen för simuleringsresultat som
visar antalet förekomster (frekvenser) och relativa frekvenser för den
numeriska skillnaden (0, 1, 2, 3, 4, 5) mellan de två tärningarna vid varje
tärningskastning.

1. Tryck på , välj ikonen för Math Box-läget och tryck sedan på .
• Då visas Math Box-menyn.

2. Välj [Dice Roll] och tryck sedan på .
• Då visas skärmen för parameterinmatning.

Dice: Välj antalet tärningar som 1, 2 eller 3.
Attempts: Mata in antalet tärningskast (antal försök) som ett värde från 1
till 250.
Same Result: Den här inställningen är vanligtvis Off (ursprunglig
standardinställning). Mer information finns i ”Inställning för Same
Result” (sida 132).

3. Välj var och en av menyinställningarna och konfigurera dem som du vill.
(1) Välj [Dice] och tryck sedan på . I menyn som visas väljer du [2

Dice] och trycker sedan på .
(2) Välj [Attempts] och tryck sedan på . På inmatningsskärmen som

visas väljer du 100 och trycker sedan på . Välj [Confirm] och tryck
sedan på .

(3) Låt [Same Result] vara inställt på Off (ursprunglig
standardinställning).

4. När alla inställningarna är som du vill ha dem väljer du [Execute] och
trycker sedan på .
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• Skärmen som visar simuleringskörningen visas och sedan ändras
skärmen till Result Type-menyn.

List: Visar en lista över resultatet för varje kast (försök).*1

Relative Freq: Visar antalet förekomster baserat på kastresultat*2 och
deras relativa frekvenser.
*1 När det finns två tärningar visas resultatet tillsammans med summan

och skillnaden för varje kast. När det finns tre tärningar visas
resultatet av varje kast tillsammans med summan av kastet.

*2 Resultat (1 till 6) för en tärning, summa (2 till 12) eller skillnad (0 till 5)
av resultaten för två tärning och summa (3 till 18) av resultaten för tre
tärningar.

5. Använd menyn Result Type för att välja ett visningsformat för resultat.
(1) Här vill vi visa antalet förekomster och relativa och relativa

frekvenser, välj därför [Relative Freq] och tryck sedan på .
• Då visas menyn val av [Sum] eller [Difference].

(2) Här vill vi visa skillnaden i resultat för varje kast, välj därför
[Difference] och tryck på .

• Simuleringsresultatet visas på Relative Freq-skärmen.

(Resultatet blir olika varje gång simuleringen körs.)

• Mer information om skärmen för simuleringsresultat finns i
”Resultatskärm för Dice Roll” (sida 131).

6. För att visa resultat med ett annat format går du till resultatskärmen och
trycker på .
• Då återgår du till menyn Result Type så att du kan upprepa steg 5 i

den här proceduren och ändra visningsformatet för resultatet.
7. Om du vill utföra en simulering med olika inställningar trycker du på 

när menyn Result Type visas.
• Detta rensar simuleringsresultatet och tar dig tillbaka till skärmen för

parameterinmatning. Utför proceduren i steg 3 igen.
8. För att avsluta Dice Roll trycker du på  medan skärmen för

parameterinmatning visas.
• Då visas Math Box-menyn igen.
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Obs!

• På Relative Freq-skärmen kan du lagra värdet i en Rel Fr-kolumncell till en variabel.
Till exempel, om du utför följande åtgärd i steg 5 ovan lagras värdet i första raden i Rel
Fr-kolumnen till variabel A:  – [A=] > [Store]. Mer information om variabler hittar du i
”Variabler (A, B, C, D, E, F, x, y, z)” (sida 35).

Resultatskärm för Dice Roll

• List-skärmen

(1) Varje rad visa ett löpnummer för kastet. Till exempel så är 1 det
första kastet, 2 det andra kastet och så vidare.

(2) A, B och C indikerar varje tärning som används. Sum avser det
totala resultatet och Diff avser skillnaden mellan resultaten för två
tärningar. Vilka kolumner som visas på skärmen beror på hur många
tärningar som används.
1 tärning: Endast A-kolumnen.
2 tärningar: Kolumnerna A, B, Sum och Diff.
3 tärningar: Kolumnerna A, B, C och Sum.

• Relative Freq-skärmen

(1) Sum eller Diff: Visar resultat för en tärning (Sum: 1 till 6), resultat för
två tärningar (Sum: 2 till 12) eller skillnader (Diff: 0 till 5) eller summa
för tre tärningar (Sum: 3 till 18).

(2) Freq: Visar antalet förekomster (frekvens) för varje kastresultat.
(3) Rel Fr: Visar den relativa frekvensen (frekvensen dividerat med antal

kast) för kastresultaten.
(4) Antal försök
(5) Värde i markerad Rel Fr-cell
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Inställning för Same Result

När du utför en simulering med Dice Roll eller Coin Toss med Same
Result på sin ursprungliga standardinställning (Off) så visas varje körning
ett annat (slumpmässigt) resultat. Om Same Result-inställningen ändras
till något annat än Off, så är de visade resultaten samma som de som
tagits fram av räknaren. Du kan använda inställningarna #1, #2 eller #3
när du vill att samma resultat ska visas av alla räknare som används av
eleverna i en klass.

Obs!

• Om du vill att flera räknare ska visa samma resultat måste du se till att nedanstående
inställningar är identiska på alla räknare.
– Antal tärningar eller mynt
– Antal försök (kast)
– Same Result-inställningen (#1, #2 eller #3)

Coin Toss
Coin Toss simulerar en, två eller tre virtuella tärningar som kastas
ett angivet antal gånger. Du kan välja någon av följande skärmar för
resultatet.

List-skärmen

Relative Freq-skärmen

Skärmen visa krona som  och klave som .

Allmän procedur för Coin Toss

Exempel: För att simulera 100 kast med tre mynt. I det här exemplet
används Relative Freq-skärmen för simuleringsresultat, och antalet krona
visas (0, 1, 2, 3) samt relativ frekvens för varje kast.
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1. Tryck på , välj ikonen för Math Box-läget och tryck sedan på .
• Då visas Math Box-menyn.

2. Välj [Coin Toss] och tryck sedan på .
• Då visas skärmen för parameterinmatning.

Coins: Välj antalet mynt som 1, 2 eller 3.
Attempts: Mata in antalet myntkast (antal försök) som ett värde från 1 till
250.
Same Result: Den här inställningen är vanligtvis Off (ursprunglig
standardinställning). Mer information finns i ”Inställning för Same
Result” (sida 132).

3. Välj var och en av menyinställningarna och konfigurera dem som du vill.
(1) Välj [Coins] och tryck sedan på . I menyn som visas väljer du [3

Coins] och trycker sedan på .
(2) Välj [Attempts] och tryck sedan på . När inmatningsskärmen visas

väljer du 100 och trycker sedan på . Välj [Confirm] och tryck
sedan på .

(3) Låt [Same Result] vara inställt på Off (ursprunglig
standardinställning).

4. När alla inställningarna är som du vill ha dem väljer du [Execute] och
trycker sedan på .
• Skärmen som visar simuleringskörningen visas och sedan ändras

skärmen till Result Type-menyn.

List: Visar en lista över resultat med krona och klave*1 för varje kast
(försök).
Relative Freq: Visar antalet förekomster av mynt som landar med krona
uppåt*2 och deras relativa frekvenser.
*1 När det finns två eller tre mynt visas antalet mynt för varje kast som

landar med krona upp.
*2 För två eller tre mynt. När det finns ett mynt visas frekvenserna för

krona och klave och de relativa frekvenserna.
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5. Använd menyn Result Type för att välja ett visningsformat för resultat.
Här vill vi visa antalet förekomster och relativa och relativa frekvenser,
välj därför [Relative Freq] och tryck sedan på .
• Simuleringsresultatet visas på Relative Freq-skärmen.

(Resultatet blir olika varje gång simuleringen körs.)

• Mer information om skärmen för simuleringsresultat finns i
”Resultatskärmen för Coin Toss” (sida 134).

6. För att visa resultat med ett annat format går du till resultatskärmen och
trycker på .
• Då återgår du till menyn Result Type så att du kan upprepa steg 5 i

den här proceduren och ändra visningsformatet för resultatet.
7. Om du vill utföra en simulering med olika inställningar trycker du på 

när menyn Result Type visas.
• Detta rensar simuleringsresultatet och tar dig tillbaka till skärmen för

parameterinmatning. Utför proceduren i steg 3 igen.
8. För att avsluta Coin Toss trycker du på  medan skärmen för

parameterinmatning visas.
• Då visas Math Box-menyn igen.

Obs!

• På Relative Freq-skärmen kan du lagra värdet i en Rel Fr-kolumncell till en variabel.
Till exempel, om du utför följande åtgärd i steg 5 ovan lagras värdet i första raden i Rel
Fr-kolumnen till variabel A:  – [A=] > [Store].

Resultatskärmen för Coin Toss

• List-skärmen

(1) Varje rad visa ett löpnummer för kastet. Till exempel så är 1 det
första kastet, 2 det andra kastet och så vidare.
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(2) A, B och C indikerar varje mynt som används. När två mynt eller
tre mynt används så visar -kolumnen till höger antalet mynt som
landar med krona upp.

• Relative Freq-skärmen

(1) Side: När du använder endast ett mynt anger  krona och  klave.
När du använder två eller tre mynt visar den här kolumnen antalet
huvuden (0 till 3).

(2) Freq: Visar antalet förekomster (frekvens) för varje kastresultat.
(3) Rel Fr: Visar den relativa frekvensen (frekvensen dividerat med antal

kast) för kastresultaten.
(4) Antal försök
(5) Värde i markerad Rel Fr-cell
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Teknisk information

Fel
Räknaren visar ett felmeddelande när ett fel inträffar av någon anledning
under en beräkning.

Visa platsen för ett fel
När ett felmeddelande visas trycker du på ,  eller  för att återgå
till den skärm som visades omedelbart innan felmeddelandet visades.
Markören placeras på den plats där felet uppstod och är klar för inmatning.
Gör nödvändiga korrigeringar av beräkningen och kör den igen.

Exempel: Om du matat in 14 ÷ 0 × 2 av misstag istället för 14 ÷ 10 × 2.

14 0 2

 (eller  eller )

1

Felmeddelanden

Syntax ERROR

Orsak:
• Problem med formatet på den beräkning du utför.

Åtgärd:
• Gör nödvändiga korrigeringar.

Math ERROR

Orsak:
• Ett mellanliggande eller slutligt resultatet av beräkningen som du utför

överskrider det tillåtna beräkningsintervallet.
• Din inmatning överskrider det tillåtna inmatningsintervall (särskilt när

du använder funktioner).
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• Beräkningen du utför innehåller en ogiltig matematisk operation (som
t.ex. delning med noll).

• När du använder en app som inte stöder komplexa tal eller medan en
skärm som inte accepterar inmatning av komplexa tal visas, försökte
du utföra en beräkning som innehåller en variabel där ett komplext tal
lagras.

Åtgärd:
• Kontrollera de inmatade värdena, minska antalet siffror och försök

igen.
• När du använder en variabel som argument för en funktion ska du se

till att variabelvärdet ligger inom det tillåtna intervallet för funktionen.
• Om du vill utföra en beräkning som innehåller en variabel där ett

komplext tal lagras, medan du använder ett läge som inte stöder
komplexa tal, eller medan en skärm som inte accepterar inmatning av
komplexa tal visas, ändrar du värdet som lagras till variabeln till ett
reellt tal.

Stack ERROR

Orsak:
• Beräkning du utför har gjort att kapaciteten för den numeriska stapeln

eller kommandostacken har överskridits.
• Beräkning du utför har gjort att kapaciteten för matrisen eller

vektorstacken har överskridits.
Åtgärd:
• Förenkla beräkningsuttrycket så att det inte överskrider stackens

kapacitet.
• Försök dela upp beräkningen i två eller flera.

Argument ERROR

Orsak:
• Problem med argumentet för den beräkning du utför.

Åtgärd:
• Gör nödvändiga korrigeringar.

Dimension ERROR (endast Matrix- och Vector-lägena)

Orsak:
• Du försöker utföra en beräkning med matriser eller vektorer vars

dimensioner inte tillåter den typen av beräkning.
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Åtgärd:
• Kontrollera måtten för matriser eller vektorer för att se om de är

kompatibla med beräkningen.

Variable ERROR (endast Equation-lägets Solver-funktion)

Orsak:
• Ett försök att köra Solver för inmatning av uttryck utan att någon

variabel ingår.
Åtgärd:
• Ange ett uttryck som innehåller en variabel.

Cannot Solve (endast Equation-lägets Solver-funktion)

Orsak:
• Räknaren kunde inte erhålla en lösning.

Åtgärd:
• Kontrollera om det finns fel i ekvationen som du matat in.
• Mata in ett värde för lösningsvariabeln som ligger nära den förväntade

lösningen och försök igen.

Range ERROR

Orsak (Table-läget):
• Ett försök att generera en nummertabell i Table-läget vars villkor gör

att den överskrider det maximala antalet tillåtna rader.
Åtgärd:
• Begränsa tabellberäkningsintervallet genom att ändra Start-, End- och

Step-värdena och försök igen.
Orsak (Spreadsheet-läget):
• Under satsvis inmatning i Spreadsheet-läget så ligger Range-

inmatningen utanför det tillåtna intervallet eller är ett cellnamn som
inte finns.

Åtgärd:
• För Range anger du ett cellnamn inom intervallet A1 till E45 med hjälp

av syntaxen: ”A1:A1”.
Orsak (Math Box-läget):
• Värdet som anges som Attempts (antal försök) för Dice Roll eller Coin

Toss ligger utanför det tillåtna intervallet eller är ett icke-heltalsvärde.
Åtgärd:
• För Attempts anger du ett heltalsvärde som ligger inom det tillåtna

intervallet.
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Time Out

Orsak (differentiell beräkning eller integrationsberäkning):
• Den aktuella differentialen eller integrationsberäkningen avslutas utan

att slutvillkoret uppfylls.
Åtgärd:
• Försök öka tol-värdet. Observera att detta också minskar lösningens

precision.
Orsak (Distribution-läget):
• Den aktuella fördelningsberäkningen avslutas utan att slutvillkoret

uppfylls.
Åtgärd:
• Ändra värdet för varje parameter.

Circular ERROR

Orsak (f(x) och g(x) funktion):
• Cirkelreferens förekommer i en registrerad sammansatt funktion

(”Registrera en sammansatt funktion” (sida 61)).
Åtgärd:
• Mata inte in g(x) i f(x) och f(x) i g(x) samtidigt.

Orsak (Spreadsheet-läget):
• Det finns en cirkelreferens (t.ex ”A1” i cell A1) i kalkylbladet.

Åtgärd:
• Ändra cellinnehållet för att ta bort cirkelreferenser.

Memory ERROR (endast Spreadsheet-läget)　

Orsak:
• Du försöker mata in data som överskrider den tillåtna

inmatningskapaciteten (1 700 byte).
• Du försöker mata in data som leder till en kedja av konsekutiva

cellreferenser (till exempel cell A2 refererad från cell A1, cell A3
refererad från cell A2..., etc.). Den här typen av inmatning orsakar
alltid att felet genereras, även om minneskapaciteten (1 700 byte) inte
överskrids.

Åtgärd:
• Ta bort onödiga data och mata in data igen.
• Minimera indata som resulterar i en kedja av konsekutiva

cellreferenser.
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Not Defined

Orsak (f(x) och g(x) funktion):
• Du försökte beräkna f(x) eller g(x) med odefinierat f(x)/g(x).

Åtgärd:
• Definiera f(x) eller g(x) innan du beräknar f(x)/g(x).

Orsak (Matrix- och Vector-lägen):
• Matrisen eller vektorn som du försöker använda har matats in utan

dimension har angetts.
Åtgärd:
• Ange dimensionen för matrisen eller vektorn och utför sedan

beräkningen igen.

Innan du drar slutsatsen att det är fel
på räknaren...
Observera att du bör göra separata kopior av viktiga data innan du utför
dessa steg.
1. Kontrollera beräkningsuttrycket för att se till det inte innehåller några fel.
2. Se till att du använder rätt läge på räknaren för typen av beräkning du

försöker utföra.
• För att kontrollera vilket läge du använder för tillfället, tryck på .

Detta markerar ikonen för det läge du använder för närvarande.
3. Om ovanstående steg inte åtgärdar problemet trycker du på tangenten

.
• Detta gör att räknaren utför en rutin som kontrollerar om

beräkningsfunktionerna fungerar korrekt. Om räknaren upptäcker
något onormalt initierar den räknarläget och rensar minnet.

4. Återställ räknarens inställningar (med undantag för Contrast och Auto
Power Off) till deras ursprungliga standardinställningar genom att utföra
proceduren nedan.
(1) Tryck på , välj en ikon för ett läge och tryck sedan på .
(2) Tryck på  och välj sedan [Reset] > [Settings & Data] > [Yes].

Byta batteri
Om skärmen som visas nedan visas direkt efter att du har startat enheten
betyder det att återstående batteriström är låg.
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Ett svagt batteri indikeras också av en suddig skärm, även om kontrasten
justeras, eller om siffrorna inte visas på displayen direkt efter att du har
aktiverat räknaren.
Om detta händer eller om ovanstående skärm visas så ska du byta
batteriet mot ett nytt.

Viktigt!

• Om du tar bort batteriet rensas allt minnesinnehåll från räknaren.

1. Tryck på (OFF) för att stänga av räknaren.
• Se till att du inte slår på strömmen av misstag när du byter ut batteriet

genom att sätta fast den främre luckan på framsidan av räknaren.
2. Ta bort batterikåpan, ta bort batteriet och sätt i ett nytt batteri med dess

plus- (+) och minuspoler (−) vända åt rätt håll, enligt bilden.

3. Sätt tillbaka batteriluckan.
4. Tryck på  för att slå på räknaren.
5. Starta räknaren.

(1) Tryck på , välj en ikon för ett läge och tryck sedan på .
(2) Tryck på  och välj sedan [Reset] > [Initialize All] > [Yes].
• Hoppa inte över ovanstående steg!
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Beräkningsprioritetssekvens
Räknaren utför beräkningar enligt en beräkningsprioritetssekvens.

• Detta innebär i princip att beräkningar utförs från vänster till höger.
• Uttryck inom parentes har högst prioritet.
• Nedan visas prioritetssekvensen för varje enskilt kommando.

1 Parentesuttryck

2

Funktioner som har parenteser (sin(, log(, f(, g(, osv.,
funktioner som kan inkludera ett argument till höger,
funktioner som kräver en avslutande parentes efter
argumentet)

3
Funktioner som kommer efter inmatat värdet (x2, x3, x-1, x!, °’
”, °, r, g, %, t), tekniska symboler (m, μ, n, p, f, k, M, G, T, P,
E), potenser ( ), rötter ( )

4 Bråk

5 Minustecken ((-)), Base Prefix (d, h, b, o)

6
Enhetskonverteringskommandon (cm in, osv.), värden
beräknade med Statistics-läget (x̂, ŷ, x̂1, x̂2)

7 Multiplikation där multiplikationstecknet utelämnas

8
Permutation (nPr), kombination (nCr), komplex polär
koordinatsymbol (∠)

9 Punktprodukt (•)

10 Multiplikation (×), division (÷)

11 Addition (+), subtraktion (−)

12 and (logisk operator)

13 or, xor, xnor (logiska operatorer)

Om en beräkning innehåller ett negativt värde kan du behöva omsluta det
negativa värdet med parenteser. Om du till exempel vill kvadrera värdet -2
måste du ange: (-2)2. Detta beror på att x2 är en funktion som föregås av

142



ett värde (prioritet 3 ovan), vars prioritet är större än det negativa tecknet,
vilket är en prefixsymbol (prioritet 5).

Exempel:
((-))2     -22 = -4

((-))2  (-2)2 = 4

Beräkningsintervall, antal siffror och
precision
Beräkningsintervallet, antalet siffror som används för intern beräkning och
beräkningsprecisionen beror på vilken typ av beräkning du utför.

Beräkningsintervall och precision

Beräkningsintervall
±1 × 10-99 till ±9,999999999 ×
1099 eller 0

Antal siffror för intern beräkning 23 siffror

Precision

I allmänhet, ±1 vid den 10:e
siffran för en enda beräkning.
Precision för exponentiell visning
är ±1 för den minst signifikanta
siffran. Fel ackumuleras vid
efterföljande beräkningar.

Indataintervall och precision och
funktionsberäkning

Funktioner Indataintervall

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632,7

Gradian 0 ≤ |x| < 1 × 1010
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tanx

Degree
Samma som sinx, utom för
|x| = (2n - 1) × 90.

Radian
Samma som sinx, utom för
|x| = (2n - 1) × π/2.

Gradian
Samma som sinx, utom för
|x| = (2n - 1) × 100.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9,999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230,2585092

sinh-1x 0 ≤ |x| ≤ 4,999999999 × 1099

cosh-1x 1 ≤ x ≤ 4,999999999 × 1099

tanhx 0 ≤ |x| ≤ 9,999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9,999999999 × 10-1

logx, lnx 0 < x ≤ 9,999999999 × 1099

10x -9,999999999 × 1099 ≤ x ≤ 99,99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0

x! 0 ≤ x ≤ 69 (x som ett heltal)

nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r är heltal)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r är heltal)
1 ≤ n!/r! < 1 × 10100 eller 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9,999999999 × 1099

√x2 + y2 ≤ 9,999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9,999999999 × 1099

θ: Samma som sinx
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a°b’c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
Det visade värdet för sekunder kan ha ett fel på
±1 vid det andra decimalkommat.

a°b’c” = x

0°0’0” ≤ |x| ≤ 9999999°59’59”
Ett sexagesimalvärde utanför ovanstående
intervall behandlas automatiskt som ett
decimalvärde.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m, n är heltal)

Men: -1 × 10100 < ylog |x| < 100

x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n + 1, 2n + 1
　 m　

 (m ≠ 0; m, n är heltal)

Men: -1 × 10100 < 1/x log |y| < 100

a b/c
Summan av heltal, täljare och nämnare
måste vara 10 siffror eller mindre (inklusive
skiljesymbolen).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

• Precision är i princip samma som beskrivs under beräkningsintervall och
precision ovan.

• xy, 
x
√y, x!, nPr, nCr-typfunktioner kräver en efterföljande intern beräkning,

vilket kan leda till att de fel som kan uppstå vid varje beräkning
ackumuleras.

• Fel är kumulativa och tenderar att vara stora i närheten av en funktions
singulära punkt och brytpunkt.

• Det intervall för beräkningsresultat som kan visas i π-formuläret när
MathI/MathO väljs för Input/Output i SETTINGS-menyn är |x| < 106.
Observera dock att det interna beräkningsfelet kan göra det omöjligt
att visa några beräkningsresultat i π-formuläret. Det kan också leda till
beräkningsresultat som ska vara i decimalform visas i π-form.

145



Specifikationer

fx-570CW
Strömkrav:
AAA-batteri R03 × 1

Ungefärlig batteritid:
2 år (baserat på en timmes drift per dag)

Strömförbrukning:
0,0008 W

Driftstemperatur:
0 °C till 40 °C

Mått:
13,8 (H) × 77 (B) × 162 (D) mm

Ungefärlig vikt:
100 g inklusive batteriet

fx-991CW
Strömkrav:
Inbyggd solcell; knappbatteri LR44 x 1

Ungefärlig batteritid:
2 år (baserat på en timmes drift per dag)

Driftstemperatur:
0 °C till 40 °C

Mått:
10,7 (H) × 77 (B) × 162 (D) mm

Ungefärlig vikt:
95 g inklusive batteriet
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Vanliga frågor

Vanliga frågor
■ Hur kan jag ändra ett bråkresultat som skapas av en

divisionsoperation till decimalform?
→ När ett bråkberäkningsresultat visas trycker du på  och väljer sedan

[Decimal] eller trycker på ( ). Om du vill att beräkningsresultaten
ska visas som decimalvärden ändrar du inställningen Input/Output på
SETTINGS-menyn till MathI/DecimalO.

■ Vad är skillnaden mellan Ans-minne och variabelminne?
→ Var och en av dessa minnestyper fungerar som behållare för tillfällig

lagring av ett enda värde.
Ans-minne: Lagrar resultatet av den senast utförda beräkningen.
Använd det här minnet för att överföra resultatet av en beräkning till
nästa.
Variabler: Det här minnet är användbart när du behöver använda
samma värde flera gånger i en eller flera beräkningar.

■ Hur hittar jag en funktion som jag använde med en äldre CASIO-
räknare på den här räknaren?

→ Du kan nå räknarens funktioner från CATALOG-menyn som visas när
du trycker på . Mer information finns i avsnitten nedan.
”Använda CATALOG-menyn” (sida 25)
”Avancerade beräkningar” (sida 45)

■ På en äldre CASIO-räknare tryckte jag på  för att ändra
visningsformatet för beräkningsresultatet. Vad ska jag göra på den
här räknaren?

→ När ett beräkningsresultat visas trycker du på . Använd menyn som
visas för att välja önskat visningsformat. Mer information finns i ”Ändra
format för beräkningsresultat” (sida 38).

■ Hur kan jag ta reda på vilket räknarläge jag använder just nu?
→ Tryck på . Då markeras ikonen för det räknaräge du använder just

nu.

■ Hur beräknar jag sin2 x

→ Till exempel för att beräkna sin2 30 =  1
4 , anger du beräkningen nedan.
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■ Varför kan jag inte mata in (i) eller beräkna ett komplext tal?
→ Du kan inte använda Calculate-läget för att mata in i eller utföra

beräkningar av komplexa tal. Använd Complex-läget för att utföra
sådana beräkningar.

■ Varför visas batteriikonen ( ) direkt efter att räknaren har startats?
→ Batteriikonen anger att batterinivån är låg. Om den här ikonen visas

byter du ut batteriet så snart som möjligt. Mer information om batteribyte
finns i ”Byta batteri” (sida 140).

■ Hur återställer jag räknaren till de ursprungliga
standardinställningarna?

→ Utför proceduren nedan för att initiera alla räknarinställningar( utom
Contrast och Auto Power Off).
(1) Tryck på , välj en ikon för ett läge och tryck sedan på .
(2) Tryck på  och välj sedan [Reset] > [Settings & Data] > [Yes].
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